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 مقدمه 1

تمامی مراحل بر اساس یک پروژه کاربردی  Etabsبرای آموزش مدلسازی تحلیل و طراحی ساه های فولادی در 

 انجام شده است. لذا مشخصات عمومی پروژه فوق بصورت زیر است.

موقعيت : تبريز 

 کاربری : مسکونی 

 : طبقه 6تعداد طبقات 

تعداد زيرزمين : ندارد 

.سيستم باربر جانبی قاب خمشی می باشد 

 می باشد سقف عرشه فولادیسيستم باربر ثقلی 

.ساختمان با شکل پذيری متوسط می باشد 

 نوع خاکII .می باشد 

 11/2و ضريب بستر خاک  کيلوگرم بر سانتی متر مربع 58/1مقاومت مجاز فشاری خاک 

 متر مکعبکيلوگرم بر سانتی

 متر می باشد 44/1متر و ضخامت آن  04/1عرض فونداسيون 

 

 

: آيين نامه های مورد استفاده 

 نظام معاونت ساختمان، ملّی مقررّات و ترويج دفتر –بارهای وارد بر ساختمان 

  -.ساختمان اجرای و مهندسی

برابر زلزله / کميتة دائمی بازنگری آيين نامة  آيين نامة طراحی ساختمانها در

 .سوّم ويراست—طراحی ساختمانها در برابر زلزله.

  طرح و اجرای ساختمانهای بتنی / دفتر ترويج و مقرّرات ملّی ساختمان، معاونت

 نظام مهندسی و اجرای ساختمان. )مبحث نهم مقرّرات ملی ساختمانی ايران(

:برنامه تحليل و طراحی سازه Etabs v 2015 

 :برنامه تحليل و طراحی پیSafe v 14.1 
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پلانهای معماری پروژه فوق بصورت زیر می باشد که در طبقات همکف تا سوم تیپ و در طبقه چهارم و 

 پنجم متفاوت می باشد. در طبقه پنجم سازه با عقب روی دارای شیب اجرا خواهد شد. 
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 مشخصات مصالح مصرفی 1-2

 

 مشخصات تحلیلی مصالح مشخصات طراحی

210  kg/cm2  روزه یا  82مقاومت فشاری

 بیشتر

240 kg /m3  جرم واحد حجمM 

4000  kg/cm2  تنش تسلیم آرماتورهای

 طولی

 Wوزن واحد حجم  

3000  kg/cm2  تنش تسلیم آرماتورهای

 عرضی

5000√fc  مدول الاستیسیته 

 νضریب پواسون  0.2  
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 بارگذاری ثقلی 1-3
 

 بارهای مرده کف 1-3-1

 

 جزئیات کف پشت بام و محاسبه وزن آن

 بار مرده پشت بام

 = 15 کیلوگرم بر مترمربع
   

 لایه رطوبتی

 ملات ماسه سیمان 0.015 * 2100 = 31.5 کیلوگرم بر مترمربع

 بتن پوکه 0.10 * 1300 = 130 کیلوگرم بر مترمربع

 بتن دال 0.09 * 2500 = 225 کیلوگرم بر مترمربع

 وزن ورق عرشه فولادی 1 * 9 = 9 کیلوگرم بر مترمربع

 وزن تیرآهن مختلط 1 * 50 = 50 کیلوگرم بر مترمربع

 سقف کاذب با اندود گچی 1 * 50 = 50 کیلوگرم بر مترمربع

 وزن تاسیسات 1 * 10 = 10 کیلوگرم بر مترمربع

 مجموع بار 520.5 کیلوگرم بر مترمربع

 مجموع بار اعمالی توسط کاربر 236 کیلوگرم بر مترمربع

 مجموع بار اعمال شده توسط نرم افزار 284 کیلوگرم بر مترمربع

 

 

 جزئیات کف طبقات و محاسبه وزن آن

 بار مرده طبقات مسکونی

 پوشش کف )سرامیک( 0.01 * 2100 = 21 کیلوگرم بر مترمربع

 پوکه معدنی 0.10 * 1300 = 130 کیلوگرم بر مترمربع

 ملات ماسه سیمان 0.015 * 2100 = 31 کیلوگرم بر مترمربع

 بتن دال 0.09 * 2500 = 225 کیلوگرم بر مترمربع

 ورق عرشه فولادی 1 * 9 = 9 کیلوگرم بر مترمربع

 وزن تیرآهن مختلط 1 * 50 = 50 کیلوگرم بر مترمربع

 کاذب با اندود گچیسقف  1 * 50 = 50 کیلوگرم بر مترمربع

 وزن تاسیسات 1 * 10 = 10 کیلوگرم بر مترمربع

 مجموع بار 526 کیلوگرم بر مترمربع

 توسط کاربر مجموع بار اعمالی 242 کیلوگرم بر مترمربع

 مجموع بار اعمال شده توسط نرم افزار 284 کیلوگرم بر مترمربع
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 بار ديوارها  1-2-3

 بار ديوارهای خارجی 

2302000015.0 mkg :آجر نسوز در نما 

21708502.0 mkgآجرکاری باآجر مجوف و ملات ماسه سیمان : 

216160001.0 mkg  ملات گچ و خاک : 

25.61300005.0 mkgاندود گچ : 

 2222 mkg 

 

 ها بار جداکننده

2858501.0 mkg: آجرکاری باآجر مجوف و ملات ماسه سیمان 

248160003.0 mkg   ملات گچ و خاک : 

213130001.0 mkgاندود گچ : 

 2146 mkg 

 پناهبار جان

21708502.0 mkg: آجرکاری باآجر مجوف و ملات ماسه سیمان 

264160004.0 mkg  ملات گچ و خاک : 

226130002.0 mkgاندود گچ : 

 2260 mkg 
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 بار زنده 1-2-0

مبحث ششم مقررات ملی ساختمان بار زنده کف ها برای طراحی به طور عمده بار گسترده  8-3-6طبق بند 

یکنواختی است که در سراسر کف اثر داده می شود.حداقل این بارها برای کاربری های مختلف در جدول 

داده شده است.و در به کارگیری این بار گسترده  2-8-3-6تا  -8-8-3-6و در بندهای  1-3-6شماره 

 الزامی است. 3-3-6رعایت ضابطه بند 

را بطور موضعی تحمل  8-3-6علاوه بر این،کف ها باید بتوانند بار متمرکز مشخص شده در جدول شماره 

ن باید طوری در نظر سانتیمتر وارد می شود و محل آ 11سانتیمتر در  11نمایند. این بار در سطحی به ابعاد 

 گرفته شود که بیشترین اثر را در عضو ایجاد کند.این بار نباید همزمان با بار یکنواخت به کف اثر داده شود.

 112کیلو گرم بر متر مربع و بار زنده بام  822چون ساختمان ما مسکونی می باشد لذا بار زنده طبقات 

کیلو گرم  122و بار بالکن ها  28شم مقررات ملی ویرایش کیلوگرم بر متر مربع و بار زنده مطابق مبحث ش

 د. بر متر مربع می باش

 جدول  بار زنده 

 ( Kg/m2بار زنده ) کاربری فضا ردیف

 055 بالکن ها و کنسولها 1

 255 واحدهای مسکونی 2

 055 راه پله 4

 

 
 

 بارگذاری جانبی 1-2-8

آید.  دست می ای به ( و بار موثر لرزهCی ضریب زلزله ) در تحلیل استاتیکی خطی با محاسبه بار زلزله

آید، بصورت زیر در نظر گرفته شده  به دست می C=ABI/Rی  متغیرهای موثر در ضریب زلزله که از رابطه

 است:

 مشخصات پروژه: 

 طبقه 6تعداد طبقات: 
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 متر 18.9ارتفاع ساختمان: 

  :Xمشخصات سازه در راستای 

 سیستم سازه: سیستم قاب خمشی 

 متوسط  فولادیسیستم مقاوم در برابر نیروهای جانبی: قاب خمشی 

Cd= 4    ,  Ω0= 3,      Hm=50 m        Ru=5     

  :Yمشخصات سازه در راستای 

 سیستم سازه: سیستم قاب خمشی 

 مشی بتن آرمه متوسط سیستم مقاوم در برابر نیروهای جانبی: قاب خ

Cd= 4    ,  Ω0= 3,      Hm=50 m        Ru=5     

 مشخصات ساختگاه:

 تبریزمحل اجرای پروژه: شهر 

 خطر نسبی زلزله: خیلی زیاد 

 0.35نسبت شتاب مبنای طرح : 

  IIنوع خاک : تیپ 

 :سازه تناوب زمان  محاسبه

 :میگردد استفاده تحلیلی تناوب زمان از

Tanx=0.91 Sec; Tany=0.91 Sec 

 :خاک مشخصات

soil type II: T0=0.1; Ts=0.5; S=1.5; S0=1 

 X:راستای در بازتاب ضريب محاسبه

T > Ts ⇒ B1 = (S + 1) × (Ts / T)= 1.37 
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A = 0.35, Ts ≺ T < 4 ⇒N = .7 × (T - Ts) / (4 - Ts) + 1 ⇒ N = 1.08 

B = 1.49 

 Y:راستای در بازتاب ضريب بهمحاس

T > Ts ⇒ B1 = (S + 1) × (Ts / T)= 1.37 

A = 0.35, Ts ≺ T < 4 ⇒N = .7 × (T - Ts) / (4 - Ts) + 1 ⇒ N = 1.08 

B = 1.49 

 زلزله ضريب بهمحاس

Cmin = 0.12 × A × I = 0.0420 

Cx = A × Bx × I / Rux = 0.35 × 1.49 × 1.0 / 5 = 0.1040 > Cmin O.K 

Cy = A × By × I / Ruy = 0.35 × 1.49 × 1.0 / 5 = 0.1040 > Cmin O.K 

 ( مدلسازی  2

 شروع ساخت مدل در نرم افزار : 2-1

 پس از باز کردن نرم افزار با کلیک بر روی آیکون  شکل یا از مسیر زیر شروع به ساخت مدل می کنیم که  و

  دهد :ی ایجاد یک فایل جدید را نشان می( تنظیمات لازم برا 1 )

 File > New Modelمسير : 

 

 ( : تنظیمات لازم برای ایجاد یک فایل جدید1شکل ) 
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 ( : این گزینه مربوط به زمانی است که بخواهیم از تنظیمات پیشگزینه اول ) 

 فرض برنامه استفاده کنیم .

( : این گزینه مربوط به زمانی است که قبلاً با نرم افزار پروژه هایی گزینه دوم )  

 تنظیمات آنها استفاده کنیم .مدل شده و بخواهیم از 

( : این گزینه مربوط به زمانی است که بخواهیم خودمان تنظیمات را گزینه سوم )

 وارد کنیم .

راه ( به هم 8کنیم بهتر است گزینه سوم را انتخاب کنیم که در شکل ) اگر برای اولین بار شروع به ساخت مدل می

 توضیحات آنها آورده شده است.

 

 : تنظیمات مدلسازی اولیه ( 8شکل ) 

(  Metric MKSـ در قسمت اول که مربوط به انتخاب واحد است واحد مورد نظر را سیستم واحد متریک ) 

 کنیم.انتخاب می

که همان جدول اشتال است را بر  Euroگردد که گزینه ت مقاطع فولادی پیش فرض تعیین میـ در قسمت لیس

 می گزینیم .

زیرا مبحث  کنیمرا انتخاب می AISC 360 - 10 انتخاب آئین نامه فولاد است گزینهـ در قسمت سوم که 

 باشد .مینامه منطبق بر این آییندهم مقررات ملی ساختمان 
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 : Grid Linesخطوط کمکی يا  2-2

Grid Lines و گذاری باشند و با توجه به موقعیت ستونمکی برای ساخت هندسه مدل سازه میخطوط ک

پله و س بندی ستونها وتیرهای اطراف راهباشد و معمولاً برابر خطوط آکمعماری هر سازه متفاوت میپلان 

 ( در زیر نمایش داده شده است : 3باشد که در شکل ) ها میانتهای طره

 

 ( : پلان آکس بندی سازه 3شکل ) 
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 (  Gridتعريف مشخصات خطوط کمکی مدلسازی )  2-2-1

حه زیر ظاهر خواهد شد که در شکل ) ها صفنامهینکردن صفحه مربوط به تنظیمات واحد و آئ   ok پس از

 ( آورده شده است : 4

 

 

 ( Grids  تعریف مشخصات خطوط کمکی مدلسازی ): 4شکل 

قسمت )  ( : 
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 ( . محور 3باشد ) می Xراستای  Grid Linesقسمت اول مربوط به  ـ

 ( . محور 4باشد ) می Yراستای  Grid Linesـ قسمت دوم مربوط به 

باشد وزمانی کاربرد دارد که می Yو  Xدر دو راستای  Grid Linesـ قسمت سوم و چهارم مربوط به فواصل 

 همه فواصل محورها از هم برابر باشد .

 

 ) ( : قسمت

 صفحه زیر ضاهر می شود : Edit Grid Dataبا کلیک بر روی گزینه 

 

 Yو  X( : تنظیم اندازه ها و مشخصات خطوط کمکی راستای  1شکل ) 

 

 ) ( : بخش

 .باشد مربوط به ابعاد و تعداد طبقات میاین بخش 
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تفاع باشد و قسمت دوم ارتفاع طبقات تیپ بوده و قسمت سوم ارمی قسمت اول مربوط به تعداد طبقات 

 دهد .پایین ترین طبقه را نشان می

 

 باشد .ای میاز تعداد طبقات ، طبقات سازه ظورنکته : من

 81شود که وزن آن بیشتر از ای محسوب میخرپشته زمانی طبقه سازه 8222امه ننکته : بر اساس آئین

 درصد وزن بام باشد .

کنیم . ) ارتفاع خرپشته را ای وارد میته را به علاوه تعداد طبقات سازهنکته : در تعیین تعداد طبقات خرپش

 اصلاح خواهیم کرد ( . Custom Story Dataقسمت  در

 

 نکته : ارتفاع طبقات تيپ و پايين ترين طبقه بصورت زير محاسبه می شود :

 نصف کف سازی پايين + نصف کف سازی بالا + ارتفاع خالص طبقه = ارتفاع طبقات تيپ

 پايين ترين طبقهکل کف سازی پايين + نصف کف سازی بالا + ارتفاع خالص طبقه = ارتفاع 
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قسمت )  ( :

 دهیم :و تنظیمات را بصورت زیر انجام میپنجره زیر باز شده  Edit Story Dataبا کلیک بر روی گزینه 

 

 ( : تنظیم ارتفاع و مشخصات مربوط به طبقات سازه 6)  شکل

 

کردن در صفحه   OKو  Grid Onlyدر مرحله آخر وقتی همه این تنظیمات را انجام دادیم با انتخاب گزینه 

Add Structural Objects شده در محیط سازه مدلETABS ( در زیر  7شود که در شکل ) نشان داده می

 آورده شده است :

 

 ( : نمایش محیط کار در نرم افزار 7شکل ) 
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 تنظيم واحدها در نرم افزار : 2-3

است کلیک کرده و با در گوشه پایین سمت ر Unitبر روی گزینه  ETABSبرای تنظیم واحدها در محیط 

-می ( آورده شده است تغییر 2نظر را بصورت زیر که در شکل )  واحدهای مورد Consistent Unitsانتخاب 

  دهیم :

 C :واحد درجه حرارت  kgf : واحد نيرو     m : واحد طول

 

 ( : تنظیم واحدها 2شکل ) 

 مشخصات مصالح : 2-0

-و از مسیر زیر تعریف می Defineاطلاعات مربوط به مصالح مصرفی پروژه در نرم افزار بایستی از منوی 

 گردد:

 Define > Material Propertiesمسير :  

 

 ( : تعریف مشخصات مصالح 2شکل ) 
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 .گیردریکا بیشتر مورد استفاده قرار میفولادی است که در آم A992Fy50( ،  2بر اساس شکل ) 

 مشخصات مصالح فولادی :  2-0-1

که  Modifyرا اصلاح خواهیم نمود و با کلیک بر روی گزینه  A992Fy50بجای اضافه نمودن مصالح جدید ، 

 ( آورده شده است آنرا اصلاح خواهیم کرد : 12در شکل ) 

 

 ( : تعریف مشخصات فولادی 12شکل ) 
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 پردازیم :هر یک می شود که به توضیحبخش زیر تقسیم می 1این پنجره به 

 ( : General Data( قسمت )  1

 

 توضیحات : 

 باشد .میدیم که فولاد پر مصرف ایران مینا ST37ـ نام فولاد که آنرا 

 کنیم .صالح را از جنس فولادی انتخاب میـ نوع م

 دارد .کنیم یعنی در همه جهات مشخصات مکانیکی یکسانی انتخاب می Isotropicـ نوع جهت تقارن را 

 گذاریم .بصورت پیش فرض باقی می باشد کهر مربوط به رنگ و نوشته مصالح میدو بخش آخـ 

 ( : Material Weight Density( قسمت )  8

 

 

مبحث ششم مقررات ملی ساختمان  1-6در این بخش وزن مخصوص فولاد را با توجه به جدول پیوست 

 .گیریم کیلوگرم بر متر مکعب در نظر می 7212

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

18 
 

 : ( Mechanical Property Data( قسمت )  3

 

 توضیحات :

10*2برابر  8-4-1-12ـ مدول الاستیسیته فولاد طبق بند 
5
 ( MPa )  2.0یاE+9 ( Kgf/m

2
در نظر گرفته  ( 

 شود .می

 شود .در نظر گرفته می 0.3برابر  3-4-1-12ـ ضریب پوآسون فولاد طبق بند 

 کنیم .فرض برنامه را انتخاب میمان پیشفولادی هـ برای ضریب انبساط حرارتی 

محاسبه  G = E / 2 (1+ν )ـ بخش چهارم مربوط به مدول برشی است که خود نرم افزار با استفاده از رابطه 

 کند .می

 ( : Design Property Data( قسمت )  4

 

 صفحه زیر ظاهر شده وآنها را بصورت زیر ویرایش خواهیم کرد : Modifyبا کلیک بر روی گزینه 
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 توضیحات :

24E+6 (Kgf/mبرابر  ST37باشد که برای فولاد (می Fyـ بخش اول حداقل تنش تسلیم ) 
2
 باشد .می ( 

37E+6 ( Kgf / mبرابر  ST37باشد که برای فولاد ( می Fuـ بخش دوم حداقل تنش گسیختگی ) 
2
 )     

 باشد .می

ه دست باشد که با استفاده از رابطه زیر ب( می Fueو  Fyeبخش سوم و چهارم تنش تسلیم مورد انتظار ) ـ 

 آید :می

 

   
   

  
              

   
   

  
              

مقطع ، افزودنیهای نظیر شکل اساساً برای انواع تولیدات فولاد متفاوت بوده و به عوامل متعددی  Ryضریب 

برده شده در طی روند تولید فولاد در کارخانجات بستگی دارد و مطابق مبحث دهم مقررات ملی بکار

 گردد :با استفاده از جدول زیر تعیین میساختمان 

 

 

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

20 
 

 برای انواع تولیدات فولاد Ryمقادیر : 1جدول 

 Ry نوع مصالح

 1.25 شدهشکل نوردای و قوطیمقاطع لوله

 1.20 شکل ، ناودانی ، نبشی ، سپری Hشکل ،  Iشده شامل مقاطع سایر مقاطع نورد

 1.15 هاها و تسمهاز ورق ، ورقمقاطع ساخته شده 

 

کردن پارامترهای گیریم اما بعداً در هنگام تنظیمرا مقادیر زیر در نظر می Fueو  Fyeبخش مقدار  نما در ای

 فوق برآورد خواهد شد .طراحی برای هر مقطع براساس جدول 

 ( : Advanced Material Property Data( قسمت ) 1

 باشد .ت پیشرفته خواص مصالح فولادی میاین قسمت مربوط به اطلاعا

 گردد .ذخیره می Define Materialلازم صورت گرفته و در صفحه  صلاحاتکردن صفحه ا OKدر آخر با 
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 تعريف مشخصات مقاطع : 8-1

 نمائیم :عریف مقاطع از مسیر زیر اقدام میت برای

 Section Define > Section properties > Frame       مسير :   

 

 ( : تعریف مشخصات مقاطع و فراخوانی مقاطع11شکل ) 

 رود .فراخوانی مقاطع فولادی به کار میبرای فراخوانی مقاطع بوده و برای  Importدر این صفحه گزینه 

 Delete Multipleرا انتخاب کرده و با گزینه  Propertiesدر این صفحه همه مقاطع موجود در قسمت 
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 Properties ماند چون نرم افزار اجازه پاک کردن همه کنیم و فقط یک گزینه باقی میآنها را پاک می

 مقاطع را نداده و در لیست حداقل یک مقطع باید باقی بماند .

 فراخوانی مقاطع :  2-8-1

 

مقاطع را بصورت زیر فراخوانی  Import New Propertiesروی گزینه با کلیک بر Frame Section قسمتدر 

 خواهیم کرد : 

 

 ( : فراخوانی مقاطع فولادی 18شکل )

 مقاطع زیر را می توانیم فراخوانی کنیم که عبارتند از : Steelن صفحه در قسمت در ای

 

( I / Wide Flange section )    مقاطع I    شکل / بال پهن   
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(ChannelSection ) مقاطع ناودانی                

 

( Box / Tube Section )     مقاطع باکس  

 

 

( Pipe Section )   ای       مقاطع لوله 

 شکل :  Iفراخوانی مقاطع  2-8-1-1

شکل صفحه زیر ظاهر خواهد شد که از آنجا مقاطع مورد نیاز را فراخوانی  Iبا کلیک برروی گزینه مقاطع 

 خواهیم کرد . 
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اشتال است را انتخاب خواهیم که همان جدول  Euroگزینه  Name of XMl Property Fileدر قسمت 

  .کرد

هم  HEBرا انتخاب خواهیم کرد که در ایران تولید می شوند البته مقاطع  IPEدر این قسمت مقاطع 

 بصورت کم کاربرد دارند و در صورت نیاز می توانیم آنها را نیز فراخوانی کنیم . 

 ای ( : فراخوانی مقاطع باکس ) جعبه 2-8-1-2

 مقاطع مورد نیاز را فراخوانی خواهیم کرد .  Boxروی گزینه مقاطع با کلیک بر

 

 . نمایش داده می شودبا ابعاد مورد نظر  Boxرا انتخاب می کنیم تا  Steel گزینه Filterدر قسمت 

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

25 
 

 ساخت مقاطع فولادی :  2-8-2

 ( : Plate Grider Sectionها ) ورقمقاطع تير 2-8-2-1

اقدام خواهیم  Add New Propertyبا استفاده از گزینه  Frame Sectionها در برای ساخت مقاطع تیر ورق

 کرد و نحوه نامگذاری و مشخصات آن بصورت زیر خواهد بود : 

 

   :Fعرض بال  * ضخامت بال  

  :Wارتفاع جان  *ضخامت جان 

 ها بر حسب میلی متر می باشد که به متر تبدیل شده اند .اندازه* توجه : 

 

 ( : ساخت مقاطع تیر ورق 13شکل ) 
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 کنیم .قطع را وارد مینام و نوع مصالح مصرفی و رنگ و نوشته م General Dataخش در ب ـ 

 کنیم . باشد را وارد میشکل بال پهن می Iشکل مقطع را که  shapeدر بخش ـ  

  User Defineمربوط به منبع مشخصات مقاطع می باشد که به صورت  Property Sourceبخش ـ  

 می باشد . 

 ابعاد مقطع را وارد خواهیم کرد .  Section Dimentionدر قسمت ـ  

 برابر صفر می باشد .  (Fillet Redius)در این قسمت شعاع گردی گوشه * 

 Total Depth عمق کلی

 Top Flange Width عرض بال فوقانی

 Top Flange Thickness ضخامت بال فوقانی

 Web Thickness ضخامت جان

 Bottom Flange Width عرض بال تحتانی

 Bottom Flange Thichness ضخامت بال تحتانی

شعاع گردی گوشه در محل اتصال 

 بال به جان

Fillet Radius 

 

باشد که در این مربوط به ضرایب اصلاح مشخصات هندسی و صلبیت می  Property Modifiresبخشـ 

 قسمت نیازی به اصلاح آنها نیست . 
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می توانیم  Show Section Propertiesبا کلیک برروی گزینه  Section Dimensionsٍ  در قسمت* توجه : 

 مشخصات هندسی مقطع را مشاهده کنیم . 

 

 

 IPE  (Double IPE  : )ساخت مقاطع جفت  2-8-2-2

اقدام خواهیم  Add New Propertyبا استفاده از گزینه  Frame Sectionدر  IPEبرای ساخت مقاطع جفت 

 :و مشخصات آن بصورت زیر می باشد  کرد و نحوه نامگذاری
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 بهم چسبيده :  IPEمقاطع جفت 

 نحوه نامگذاریIPE    => 2نمره پروفيل مورد نظر

 

2 IPE 160 

 با فاصله :  IPEمقاطع جفت 

 نحوه نامگذاری IPE 2 <= نظرشماره پروفيل مورد @ فاصله   
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X :  شوند.    فاصله بین دو مرکز تیر آهن برای اینکه هر دو گشتاور اصلی مساوی هم و معادل 

 را می توان از جدول اشتال استخراج نمود . xفاصله 

 باشد .می   در جدول اشتال همان  x توجه :

 : Auto Selectساخت مقاطع فولادی به روش  2-8-2-3

ها و مهاربندها را در یک بسته های فولادی این امکان وجود دارد که مقاطع لازم برای تیرها، ستوندر سازه

تعریف کرده و به نرم افزار شناسایی کنیم تا نرم افزار در هنگام تحلیل در این بسته اولین مقطعی که ظرفیت 

روش برای افرادی که از تجربه کافی برخوردار  کند و اینآن برای المان مورد نظر جوابگو باشد را انتخاب می

کند تا به مقطع بهینه برای طراحی دست یافت. این روش با توجه به اینکه مزیت خوبی نیستند راهنمایی می

-دارد اما در هنگام استفاده از این روش تیپ بندی مشکل خواهد بود که این دلیل نیز جزء عیوب آن می

 باشد.

        Define>Select Properties>Frame Section>Add New Propertiesمسير : 

 

 Auto Select( : ساخت مقاطع به روش  14 شکل )
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کلیک کنیم صفحه زیر ظاهر خواهد شد که تنظیمات را  Auto Select( وقتی برروی گزینه 14در شکل )

 بصورت زیر انجام خواهیم داد:

 

 نام و نوع و نوشته مقطع را انتخاب خواهیم کرد. General Dataدر قسمت  -

 قرار خواهیم داد. Auto Selectآن را در حالت  Shapeدر قسمت  -

 کنیم :مقاطع مورد نظر را بصورت زیر انتخاب می Choose Section in Auto Select listدر قسمت  -
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-را به جدول سمت راست انتقال میآنها  Addدر جدول سمت چپ مقاطع مورد نظر را انتخاب و با گزینه 

 ایم(.دهیم. )مثلا در شکل فوق مقاطع را برای ستونها انتخاب کرده

 دهيم.همين کار را برای تيرها و مهاربندها نيز انجام می

 

 سيستم باربر ثقلی 8-6

 سقف کامپوزيت و عرشه فولادی 2-6-1

 اعضای خمشی با مقطع مختلط

 شوند.بندی میگروه زیر طبقه اعضای خمشی با مقطع مختلط به سه

 الف( اضای خمشی با مقطع فولادی و دال بتنی متکی بر آن به همراه برشگیر

 ب( اعضای خمشی با مقطع مختلط محاط در بتن

 پ( اعضای خمشی با مقطع مختلط پر شده با بتن

 عرض موثر و حداقل ضخامت دال بتنی 12-8-2-3-1

نماید، نباید از کوچکترین مقادیر با آن به صورت مختلط عمل می عرض موثر دال بتنی که در هر طرف تیر

 زیر بزرگتر در نظر گرفته شود.

 های تیر(گاه. یک هشتم دهانه تیر )مرکز تا مرکز تکیه1

 . نصف فاصله محور تیر تا محور تیر مجاور8

 . فاصله محور تیر تا لبه دال3

 گردد.می میلی متر مقرر 22تبصره: حداقل ضخامت دال بتنی، 
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ریزی دال بتنی از پایه موقت در زیر تیر در صورتی که در اعضای خمشی با مقطع مختلط، در هنگام بتن

، باید به تنهایی fcدرصد مقاومت مشخصه  71فولادی استفاده نشود، عضو فئلادی تا قبل از رسیدن بتن به 

بندی( حین اجرا )نظیر بار ناشی از قالبدارای مقاومت کافی برای تحمل وزن خود، وزن بتن تر و بارهای 

 تعیین گردد. 1-8-12باشد. مقاومت خمشی عضو فولادی تنها، باید طبق الزامات بخش 

 

 مقاومت خمشی مقاطع مختلط دارای برشگير

 الف( مقاومت خمشی مثبت

و  2/2ضریب کاهش مقاومت برابر  фbباشد که در آن می фbMnمقاومت خمشی مثبت طراحی مساوی 

Mn باشد که باید بر اساس حالت حدی تسلیم به شرح زیر تسلیم شود.مقاومت خمشی مثبت اسمی می 

. در صورتی که 1
 

  
     √

 
  
باید بر اساس توزیع پلاستیک تنش بر روی مقطع  Mnباشد،  ⁄

 مختلط تعیین گردد.

 

 توزیع پلاستیک تنش در مقطع مختلط
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. در صورتی که 8
 

  
     √

 
  
های الاستیک با باید بر اساس روی هم گذاری تنش Mnباشد  ⁄

های موقت برای حالت حدی تسلیم در تارهای انتهایی فرض مقطع تبدیل یافته و با در نظر گرفتن اثر پایه

 تعیین گردد. به عبارت دیگر: (My)مقطع مختلط 

 

12-8-2-12 Mn= Min(Mn1,Mn2)                                                                                 

                                        

 

 در روابط فوق:

Mn1  لنگر خمشی نظیر تنش =Fy در دورترین تار فولادی مقطع تبدیل یافته 

Mn2  لنگر خمشی نظیر تنش =fc7/2 در دورترین تار دال بتنی در مقطع تبدیل یافته 

Fy تنش تسلیم فولاد = 

fc ای بتن= مقاومت فشاری مشخصه نمونه استوانه 

tw ضخامت جان تیر فولادی = 

h های نورد شده و فاصله آزاد بین دوبال برای = فاصله بین شروع گردی ریشه جان به بال برای نیمرخ

 مقاطع فولادی ساخته شده از ورق
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 هتوزیع الاستیک تنش در مقطع مختلط تبدیل یافت

 ب( مقاومت خمشی منفی

 Mnو  2/2ضریب کاهش مقاومت برابر  фbباشد که در آن می фbMnمقاومت خمشی منفی طراحی مساوی 

 1-8-12باشد که باید بر اساس مقطع فولادی تنها مطابق الزامات بخش مقاومت خمشی منفی اسمی می

 تعیین شود.

توان بر اساس توزیع پلاستیک تنش بر روی به عنوان روش جایگزین، مقاومت خمشی منفی اسمی را می

 مقطع مختلط با منظور کردن اثر آرماتورهای طولی تعیین نمود، مشروط بر اینکه:

 باشد. 1-8-12. مقطع فولادی فشرده و دارای اتکای جانبی کافی مطابق الزامات بخش 1

 وصل شده باشد. . در ناحیه لنگر منفی، دال بتنی به کمک برشگیرهای کافی به تیر فولادی8

. در محدوده عرض موثر دال بتنی، آرماتورهای موازی با محور تیر به طور کامل الزامات مربوط به 3

 چسبندگی و طول مهاری را مطابق مبحث نهم مقررات ملی ساختمان برآئرده نمایند.

 های فولادی شکل داده شدهپ( مقاومت خمشی مقاطع مختلط به همراه ورق

های فولادی شکل داده شده و احی مقاطع مختلط متشکل از دال بتنی بر روی ورقمقاومت خمشی طر

 Mnو  2/2کاهش مقاومت برابر  ضریب фbباشد که در آن می фbMnمتصل به مقطع فولادی مساوی 
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و با رعایت الزامات زیر تعیین  3-3-2-8-12باشد که باید بر اساس الزامات بند مقاومت خمشی اسمی می

  گردد.

 ها( ملاحضات و محدودیت1-پ

میلی متر بیشتر باشد. پهنای متوسط  71نباید از  (hr)های فولادی شکل داده شده . ارتفاع اسمی ورق1

میلی متر باشد، لیکن در محاسبات نباید بزرگتر از حداقل پهنای  12های پرشده با بتن نباید کمتر از کنگره

 دی شکل داده شده در نظر گرفته شود.آزاد )خالص( در نزدیکی سطح فوقانی ورق فولا

میلی متر به مقطع فولادی متصب شوند.  82های برشگیر با قطر حداکثر میخ. دال بتنی باید به وسیله گل8

ها باید از طریق ورق فولادی شکل داده شده یا به طور مستقیم به مقطع فولادی جوش شوند. در هر میخگل

ها که از بالای ورق میخمقطع فولادی زوب شوند. پس از نصب، ارتفاع گلها باید روی بال میخحال گل

ها میخمیلی متر کمتر باشد. پوشش بتن روی گل 42شود، نباید از گیری میفولادی شکل داده شده اندازه

 میلی متر باشد. 11نباید کمتر از 

 میلی متر باشد. 12کمتر از . ضخامت دال بتنی در قسمت فوقانی ورق فولادی شکل داده شده نباید 3

میلی متر به مقطع فولادی و سایر اعضای  412های فولادی شکل داده شده باید در فواصلی حداکثر . ورق4

ای های نقطهها و جوشهای برشگیر، ترکیبی از گل میخمیختوانند گلگاهی مهار شوند. این مهارها میتکیه

 ح باشد.یا هر راهکار ارائه شده توسط مهندس طرا
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 های فولادی شکل داده شدههای ورقملاحضات و محدودیت

 

 باشد.های آنها عمود بر محور تیر میهای فولادی شکل داده شده که کنگره( ورق8-پ

باید از بتن موجود در زیر سطح فوقانی  Acدر تعیین مشخصات هندسی مقطع مختلط و نیز در محاسبه 

 (.1-2-8-12ورق فولادی شکل داده شده صرف نظر شود )شکل 

 

 باشدهای آنها موازی با محور تیر میهای فولادی شکل داده شده که کنگرهورق

توان از بتن موجود در زیر سطح فوقانی می Acدر تعیین مشخصات هندسی مقطع مختلط و نیز در محاسبه 

توان در روی های فولادی شکل داده شده را میورق فولادی شکل داده شده استفاده نمود. همچنین، ورق

 گاهی از هم جدا کرد تا در روی بال مقطع فولادی یک ماهیچه بتنی تشکیل شود.تیر فولادی تکیه
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د، پهنای متوسط میلی متر یا بزرگتر باش 42 (hr)های فولادی شکل داده شده چنانچه ارتفاع اسمی ورق

میخ در پهنا میلی متر برای حالت یک گل 12گاهی نباید کمتر از های پر شده با بتن در روی تیر تکیهکنگره

 میخ باید افزایش یابد.برابر قطر گل 4میخ اضافی، به ازای باشد. این پهنای حداقل برای هر گل

 

 باشدبا محور تیر می های آنها موازیهای فولادی شکل داده شده که کنگرهورق

 ت( انتقال بار بین تیر فولادی و دال بتنی

 ( نواحی لنگر خمشی مثبت1-ت

 . مقاومت برش افقی مورد نیاز1

برای عملکرد مختلط کامل، برش افقی مورد نیاز باید به شرح زیر برابر کوچکترین مقدار محاسبه شده بر 

 ع فولادی در نظر گرفته شود.های حدی خردشدگی بتن و تسلیم کششی مقطاساس حالت

 خردشدگی بتن 

(12-8-2-12 )Vhu = 0.85fcAc                                                                                      

                                       

 تسلیم کششی مقطع فولادی 

(12-8-2-82 )Vhu = FyAs                                                                                            
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 در روابط فوق:

fc ای بتن= مقاومت فشاری مشخصه نمونه استوانه 

Ac سطح مقطع دال بتنی در محدوده عرض موثر = 

As مساحت مقطع فولادی = 

Fy تنش تسلیم فولاد مقطع فولادی = 

 . مقاومت برش افقی اسمی8

مقاومت برش افقی اسمی اعضای با مقطع مختلط متکی بر دال بتنی و دارای برشگیر باید مطابق رابطه زیر 

 بر اساس مقاومت برشی برشگیرها تعیین گردد.

(12-8-2-81 )Vhn = ΣQn                                                                                             

                                             

 که در آن:

ΣQn های برشی اسمی برشگیرها در حد فاصل نقاط لنگر خمشی مثبت حداکثر و لنگر = مجموع مقاومت

 .7-2-8-12صفر مطابق مقررات بند 

بایستی از طریق برقراری رابطه زیر و بدون احتساب ضریب کاهش . تعداد، فاصله و مشخصات برشگیرها 3

 مقاومت تعیین گردد.

(12-8-2-88 )Vhn≥Vhu                                                                                                

                                            

 منفی( نواحی لنگر خمشی 8-ت

 . مقاومت برش افقی مورد نیاز1
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در تیرهای پیوسته که درآن میلگردهای طولی در نواحی لنگر خمشی منفی به صورت مختلط با مقطع 

نمایند، برای عملکرد مختلط کامل، مقاومت برش افقی مورد نیاز باید بر اساس حالت حدی فولادی عمل می

 ردد.تسلیم آرماتورهای طولی از رابطه زیر تعیین گ

(12-8-2-83 )Vhu = FyrAsr                                                                                           

                                          

 که در آن:

Asr گاه داخلی= سطح مقطع کل میلگردهای طولی واقع در عرض موثر در روی تکیه 

Fyr لیم آرماتورهای طولی= تنش تس 

 . مقاومت برش افقی اسمی8

مقاومت برش افقی اسمی اعضای مختلط متکی بر دال بتنی و درای برشگیر در نواحی لنگر منفی باید مطابق 

 رابطه زیر بر اساس مقاومت برشی برشگیرها تعیین گردد.

(12-8-2-84 )Vhn = ΣQn                                                                                              

                                            

 که در آن:

ΣQn های برشی اسمی برشگیر در حد فواصل نقاط لنگر خمشی منفی حداکثر و لنگر = مجموع مقاومت

 7-2-8-12صفر مطابق مقررات بند 

. تعداد، فاصله و مشخصات برشگیرها بایستی از طریق برقراری رابطه زیر و بدون احتساب ضریب کاهش 3

 مقاومت تعیین گردد.

(12-8-2-81 )Vhn≥Vhu                                                                                                
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 مقاومت خمشی مقاطع مختلط محاط در بتن 12-8-2-3-4

 

ضریب کاهش مقاومت  фbباشد که در آن می фbMnمقاومت خمشی مقاطع مختلط محاط در بتن مساوی 

 های زیر تعیین شود.باشد که باید بر اساس یکی از روشمقاومت خمشی اسمی می Mnو  2/2برابر 

 

های های الاستیک با فرض مقطع تبدیل یافته و با در نظر گرفتن اثر پایهگذاری تنشهم. بر اساس روی 1

 (My)موقت برای حالت حدی تسلیم )اولین نقطه تسلیم( در مقطع مختلط 

 (Mp). بر اساس توزیع پلاستیک تنش بر روی مقطع فولادی تنها 8

تواند بر اساس یکی از خمشی اسمی آنها می. در صورت تعبیه برشگیرهای کافی در اینگونه اعضا مقاومت 3

 ها بر روی مقطع مختلط تعیین گردد.های توزیع پلاستیک تنش یا سازگاری کرنشروش
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 Define > Section Properties > Deck Sectionمسیر تعریف مشخصات سقف کامپوزیت: 

 

 : تنظیمات مشخصات سقف کامپوزیت11شکل

 Define > Section Properties > Deck Sectionمسیر تعریف مشخصات سقف عرشه فولادی: 

باشد؛ با اين تفاوت که در اين سقف عرشه فولادی تقريبا به نوعی همانند سقف کامپوزيت می

 مراجعه بفرمائيد. 1شود. برای مطالعه بيشتر به پيوست سقف، از ورق موجدار نيز استفاده می
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 تنظیمات مشخصات سقف عرشه فولادی :16شکل



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

43 
 

 

 

 

 ورق گالوانیزه و میلگردهای حرارتی سقف عرشه فولادی  اجرای: 17شکل  
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 انتخاب سيستم مقاوم جانبی 2-7

 از جمله سیستمهای مقاوم جانبی متداول عبارتند از :در سازه های فولادی 

 سيستم قاب مهاربند: 2-7-1

 مقابل بارهای جانبی هستند.در این سیستم مهاربندها عضو مقاوم در  -

 تیرها و ستونها در این سیستم، نقشی در مقابل بارهای جانبی ندارند. -

 اتصالات تیر به ستونها بصورت مفصلی است. -

 اتصالات مهاربندها به تیر  و ستون مفصلی است. -

 

 

 

 

 

 علامت اتصال مفصلی
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 موارد زير توصيه گردد:در اين سيستم بايد در رابطه با جانمائی مهاربندها به 

 مهاربندها باید بصورت متقارن در طرفین مرکز سختی قرار بگیرند. -

 

 مهاربندی متقارن در پلان
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قرار دادن مهاربندها در قابهای طویل باید به گونه ای باشد که توزیع سختی در طول قاب  -

 یکنواخت و متعادل باشد.

 

 رفتار لرزه ای نامناسب

 

 

 ای مناسب رفتار لرزه
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ی افقی مولفههایی قرار بگیرند که تا حد امکان مهاربندها خصوصا مهاربندهای واگرا در دهانه -

 قابل توجهی داشته باشند.

 

 مولفه افقی ناچیز و رفتار لرزه ای نامناسب

 

 و رفتار لرزه ای نامناسبکافی مولفه افقی 
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 شوند:و واگرا تقسيم می دسته همگرا 2به طور کلی مهاربندها به  2-7-1-1

 :ها عبور کند یا نقطة اگر محور طولی مهاربندها از محل تقاطع تیر و ستون مهاربند همگرا

انتهایی دو مهاربند موجود در یک قاب در یک محل مشترک به تیر برخورد کنند به آنها 

همگرای معمولی به شدة های مهاربندیاز نظر آئین نامه قاب شود.مهاربندهای همگرا گفته می

های فرا ارتجاعی محدودی بدون کاهش شود که از آنها انتظار تغییر شکلهایی گفته میقاب

 رود.قابل ملاحظه در مقاومت اعضا و اتصالات آنها تحت اثر زلزله طرح می

 )مناسب برای مناطق لرزه خیز( 

 

مهاربندهای همگرا هستند که مبحث دهم مقررات ای از دیگر انواع ای و نیم دروازهشکل دروازه Kمهاربندی 

هایی که نیروی باد پذیرد اما در سازهملی ساختمان آنها را به عنوان سیستم باربر جانبی تحت بار زلزله نمی

 توان از این نوع مهاربندها استفاده کرد.ها ( میشود ) مانند سولهبه عنوان نیروی جانبی بحرانی شناخته می
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  های مهاربندی شدة واگرا محل تقاطع محور طولی مهاربند و تیر : در قابای واگرامهاربنده

فاصلة اندکی با اتصال تیر و ستون دارد و یا دو مهاربند در یک قاب از یک نقطة مشترک در تیر 

های مختلفی است که مهمترین آنها به صورت زیر کنند این دسته نیز شامل حالتعبور نمی

 است:

 

ای که بین نقاط تلاقی محورهای دو عضو قطری مهاربندی روی تیر یا بین نقطة تلاقی محور عضو ناحیهبه  

ای ها رفتار جانبی لرزهشود. در این نوع قابمهاربندی تا گره اتصال تیر به ستون قرار دارد تیر پیوند گفته می
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ها و مشی و برشی تیرها و ستونها و عملکرد خسازه ترکیبی از عملکرد خمشی و برشی تیرها و ستون

در اثر اعمال بار جانبی مهاربندهایی که دارای شیب هم جهت  باشد.عملکرد کششی و فشاری مهاربندها می

با نیروی جانبی هستند تحت کشش قرار گرفته و مهاربندهایی که در جهت مخالف قرار دارند تحت فشار 

شود با ی زلزله به صورت رفت و برگشتی به سازه اعمال میگیرند شایان ذکر است از آنجا که نیروقرار می

 عوض شدن جهت نیروی زلزله رفتار مهاربندها نیز معکوس خواهد شد.

 

های اگر بارگذاری جانبی وارده بر سازه ناشی از اثر باد یا اثر زلزله نکات تکميلی مهاربندهای همگرا:

باشد، در این حالت با توجه به اینکه مصالح تجاعی میخفیف و متوسط باشد رفتار مهاربندها در محدودة ار

فولادی مصالحی با رفتار یکسان در کشش و فشار هستند )اصطلاحا رفتاری همسانگرد دارند( هر دو مهاربند 

 دهند.سختی و مقاومت یکسانی از خودشان می

به مهاربندها زیاد بوده و ای قوی باشد نیروی محوری وارد شده اگر بارگذاری جانبی ناشی از اثر زلزله

کند در این شرایط با افت سختی و مقاومت در مهاربند فشاری سهم مهاربندهای فشاری غالبا کمانش می

نیروی مهاربند کششی بیشتر شده و ممکن است مهاربند کششی در مقابل این نیروی افزایش یافته تسلیم 

های های بزرگ حالتی است که در قابنگام زلزلهشود کمانش مهاربند فشاری و تسلیم مهاربند کششی در ه

گیرد که در ادامه نامه ضوابطی را در نظر میشود به همین دلیل آیینمهاربندی شدة همگرا به وفور ایجاد می

 پردازیم.به آن می

 

 مهاربندهای واگرا:نکات تکميلی 

پذیری آنها ایده آل نیست و شکل های مهاربندی شده همگرا سختی مناسبی در برابر بار جانبی داشتهقاب

ی اجرای توان از واگرا استفاده کرد که اگر درست طراحی و اجرا شود هزینهپذیری میبرای بهتر شدن شکل

 آن نسبت به همگرا بیشتر است.
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 سيستم قاب خمشی 2-7-2

 در این سیستم تیرها و ستونها اعضای مقاوم جانبی هستند. -

 های مهاربندی دارد.نسبت به سازهپذیری بیشتری این سیستم شکل -

 اتصالات تیر به ستون در این سیستم گیردار است. -

 شتری نسبت به سیستم مهاربندی است.این سیستم دارای درجه نامعینی بی -

 

باید دقت داشته باشیم که طراحی قابهای خمشی باید به گونه ای باشد که فلسفه تیر ضعیف و 

ای باید به گونه ای صورت قوی رعایت شده باشد. یعنی در قابهای خمشی، طراحی لرزهستون 

 بگیرد که تیرها قبل از ستونها تسلیم شوند.

 علامت اتصال گيردار
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 در شکل بالا چون تیرها قبل از ستونها وارد مرحله غیرخطی شده اند سازه دارای رفتار لرزه ای مناسب است.

 

بل از تیرها به مرحله تسلیم رسیده اند، رفتار لرزه ای قابل قبولی در شکل بالا با توجه به اینکه ستونها ق

 ای قابل اعتماد نیست.نداشته و پایداری چنین سازه
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 سيستم دوگانه  2-7-3

در سیستمهای دوگانه فولادی، قابهای مهاربندی و قابهای خمشی بصورت همزمان در یک راستا مورد 

 استفاده قرار میگیرند.

 در این سیستمها:

امعینی ا حد قابل قبولی برخوردار است که این موضوع سبب می گردد که قابلیت درجه ن -

 ای افزایش یابد.زهاعتماد به پایداری چنین سا

در این سیستم مهاربندها و قاب خمشی، هر کدام به نسبت سختی از نیروهای جانبی سهم  -

 می برند.

-بالایی، قاب مهاربند را نگه میدر  طبقات پایین این سیستم مهاربند قاب را و در طبقات  -

دارد. یعنی در طبقات پایین این سیستم نقش مهاربند د تحمل نیروهای جانبی بیشتر از 

 کند.قاب است و در طبقات بالائی بر عکس این موضوع صدق می

 اتصالات تیر به ستون در این سیستم گیردار است. -

 است. اتصالات مهاربند به تیر و ستون در این سیستم مفصلی -

 

 
 

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

54 
 

 تعریف بارها ثقلی و جانبی  8-2

زم به توضیح است که در این جزوه نوع سیستم مقاوم جانبی قاب خمشی انتخاب شده است. بعد از انتخاب لا

 گردد. سیستم مقاوم جانبی، در این مرحله بارهای ثقلی و جانبی وارد بر سازه در نرم افزار تعریف می

 Load Pattern     Define <مسیر:

  ( بار مردهDead ) 

  ( بار زندهLive ) 

 

 ( Live( و زنده )  Deadالگوی بار مرده ) 

 

  ( بار زنده بامLive Roof ) 
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 ( Live Roof) الگوی بار زنده بام 

 بار معادل تیغه ( بندیLive Partition ) 

 

 ( Live Partition) بندی الگوی بار معادل تیغه

  ( بار برفSnow ) 

 

 ( Snow) الگوی بار برف 
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  بار زلزله استاتیکی در جهتX  (EX ) 

 

 X ( EX )بار زلزله استاتیکی در جهت 

 User( انتخاب شده و نحوه پخش بار جانبی )  Seismicای ) از نوع لرزه Xبار لرزه ای راستای 

Coefficient جرم لرزه ای هر طبقه است نحوه پخش بار در ارتفاع سازه بر اساس یعنی  .شود( انتخاب می

 Modify Lateralبا کلیک بر روی گزینه  نیز به همین صورت است. 8222که روش توزیع بار آیین نامه 

Load هر خواهد شد که برای راستای صفحه زیر ظاX .تنظیمات مربوطه است 

 

 دهد که برای بار جهت و خروج از مرکزیت را نشان می Direction and Eccentricityدر بخش  -
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 (EX  فقط جهت )X کنیم.را انتخاب می 

 می گردد. ( را وارد  K( و ضریب )  Cضریب زلزله )  Factorsدر قسمت  -

 81کنیم که اگر وزن خرپشته بیشتر از بازه توزیع بار را مشخص می Story Rangeدر قسمت  -

درصد باشد  81رفت اما اگر کمتر از درصد وزن بام باشد توزیع بار را تا طبقه بام در نظر خواهیم گ

 توزیع بار تا طبقه بام در نظر گرفته خواهد شد.

 

  بار زلزله استاتیکی در جهتY  (EY ) 

 

 

 

 Y  (EY )بار زلزله استاتیکی در جهت 
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  بار زلزله استاتیکی در جهتX  ( با خروج از مرکزیت مثبت و منفیEX All ) 

 

 

 

 

 ( EX All)  با خروج از مرکزیت مثبت و منفی Xبار زلزله استاتیکی در جهت 

 

بعد ساختمان در نظر گرفته  درصد 8دهد که مقدار خروج از مرکزیت را نشان می Ecc . Ratioدر قسمت 

 شده است.
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  بار زلزله استاتیکی در جهتY  ( با خروج از مرکزیت مثبت و منفیEY All ) 

 

 

 

 

 

 ( EY All)  خروج از مرکزیت مثبت و منفیبا  Yبار زلزله استاتیکی در جهت 
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  ( بار اصلاح جرم طبقاتMass ) 

 

 

 ( Mass) الگوی بار اصلاح جرم طبقات 

انتخاب شود تا فقط وزن مربوط به نیم طبقه در پایین و بالا اعمال  Otherدقت شود که نوع این بار از نوع 

 شود و در ترکیبات بار این بار اضافه نگردد.

 

  ( بار قائم زلزلهEV ) 

 

 

 ( EV) الگوی بار قائم زلزله 

 انتخاب خواهد شد. Other نوع بار از نوع  Massدر این الگوی بار نیز همانن الگوی بار 
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  ( بارهای ناشاغولیNational Load ) 

 

 

 (National Loadالگوی بارهای ناشاقولی ) 

بوده و نحوه توزیع  Otherشود و نوع بار تعریف می Yو  Xاین الگوی بار برای تمامی بارهای ثقلی در جهت 

شود و با کلیک بر روی در نظر گرفته می 228/2گیرد و مقدار آن قرار می Autoبارهی جانبی در حالت 

-پنجره زیر ظاهر خواهد شد و نوع بار و مقدار و جهت آنها قابل تغییر می Modify Lateral Loadگزینه 

 باید تعریف گردد. yو  xاست که برای بارهای ثقلی در راستای لازم به توضیح  باشد.
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 ترکيبات بارگذاری 2-9

شود و طبق مبحث ششم مقررات ترکیبات بار به منظور احتمال همزمانی تأثیر بارها در یک سازه تعیین می

ضرایب جزئی  اند و در مواردی کههای فولادی ترکیبات بار لازم معرفی شدهملی ساختمان برای ساختمان

های رسمی نامههای مجاز محاسباتی در ترکیب بارهای مقررات ملی ساختمان و دیگر آئینایمنی و یا تنش

 های معتبر دنیا در نظر گرفت.نامهتوان طبق سایر آئینکشور وجود نداشته باشد، آنها را می

 های فولادیهای حدی مقاومت در طراحی ساختمانترکیب بارهای حالت

1) 1.4D 

2) 1.2D+1.6L+0.5(Lr or S or R) 

3) 1.2D+ 1.6(Lr or S or R)+{L or 0.5(1.4W)} 

4) 1.2D+1.0(1.4W)+L+0.5(Lr or S or R) 

5) 1.2D+1.0E+0.2S 

6) 0.9D+1.0(1.4W) 

7) 0.9D+1.0E 

8) 1.2D+0.5L+0.5(Lr or S)+1.2T 

9) 1.2D+1.6L+1.6(Lr or S)+1.0T 

 

D :بار مرده ،L :بار زنده ،Lr : ،بار زنده بامS : ،بار برفR : ،بار بارانW : ،بار بادE : ،بار زلزله طرح F : بار

-بار خودکرنشی از قبیل اثرات تغییرات دما، نشست پایه: Tناشی از سیال با فشار و ارتفاع حداکثر مشخص، 

 ها و وارفتگی

 

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

63 
 

افزار وارد در نرمهای هر سازه ترکیبات بار لازم را انتخاب کرده و آنها را بسته به بارهای موجود در پروژه

خواهیم نمود. لازم به توضیح است که با توجه به اینکه در این جزوه سیستم مقاوم جانبی قاب خمشی است، 

 8222لذا تمامی ستونها در محل تلاقی دو سیستم مقاوم جانبی هستند و باید بر اساس ضوابط آیین نامه 

می توان بجایی اعمال بارهای  8222اساس آیین نامه نیروی زلزله با زاویه بحرانی به سازه وارد گردد. بر 

در ادامه آورده  Etabsاستفاده نمود که نحوه تعریف آن در   32-122جانبی با زاویه بحرانی، از ترکیب بار 

 شده است.

 افزاردر نرم 34-144تعريف قاعده  2-9-1

 توان از مسیر زیر اقدام نمود:برای تعریف زلزله متعامد می

  Define > Load Casesمسیر:  

 باشد.ایم قابل رویت میتعریف کرده  Load Patternدر این پنجره تمامی بارهایی که در بخش 

 

 Modify/Showو سپس با کلیک بر روی گزینه  EXAllبا کلیک بر روی بار  32-122برای تعریف قاعده 

Case  گیرد.صورت میتنظیمات لازم 
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 ( EXAll + 0.3EYافزار ) در نرم 32-122تعریف قاعده 

 Xکنیم که ما در شکل فوق نام بار را برای زلزله در جهت در این پنجره ابتدا نام بار را انتخاب می -

ایم و بر اساس آن نامگذاری صورت گرفته درصد در نظر گرفته 32برای  Yبطور کامل و در جهت 

 است.

و انتخاب حالت بار مورد نظر و وارد کردن  Addبا کلیک بر روی گزینه  Load Appliedدر بخش  -

 را تعریف کنیم. 32-122درصد برای آن می توانیم قاعده  32مقدار 
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 ( EXAll - 0.3EYافزار ) در نرم 32-122تعریف قاعده 

 

 ( EYAll + 0.3EXافزار ) در نرم 32-122تعریف قاعده 
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 ( EYAll - 0.3EXافزار ) در نرم 32-122تعریف قاعده 

 

نامه خود را انتخاب نموده و ترکیبات بار را فراخوانی نمائیم؛ توانیم آئینمی 122-32بعد از تعریف قاعده 

نامه را انتخاب خواهیم بسته به نوع سازه آئین اقدام خواهیم نمود. Designنامه از منوی برای تنظیمات آئین

با توجه به اینکه مبحث دهم مقررات ملی ساختمان  نمود و سپس ترکیبات بار را فراخوانی خواهیم کرد.

-AISC 360 برگرفته از آیین نامه فولاد آمریکا است، لذا می توان در طراحی سازه های فولادی از آیین نامه 

 برای فراخوانی ترکیبات بار استفاده نمود.: 10
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 فراخوانی ترکيبات بار 3 2-9

 Define > Load Combinationمسير: 

 

 

توانیم ترکیبات بار را بصورت دستی اعمال کنیم و می Add New Comboدر این پنجره با استفاده از گزینه 

میتوانیم ترکیبات بار بار را فراخوانی کنیم و با کلیک  Add Default Design Combosبا استفاده از گزینه 

 بر روی این گزینه خواهیم داشت:
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 Steel Frame Design های فولادیسازهترکيبات بار برای طراحی 

 Composite Beam Design ترکيبات بار برای تيرهای کامپوزيت

 Concrete Frame Design های بتنیترکيبات بار برای طراحی سازه

 Concrete Shear Wall Design ترکيبات بار برای طراحی ديوار برشی

 

  در انتهای صفحه اگر گزینهConvert to User Combination ( Editable) توانیم را فعال کنیم می

 ترکیبات بار را ویرایش کنیم.
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 مدلسازی 2-14

 ترسيم ستون  2-14-1

ستونها را می توان هم در حالت پلان و هم در حالت نما ترسیم نمود. برای ترسیم ستون در حالت پلان و 

 ابزارهای ترسیم استفاده نمود.نما از مسیر زیر یا آیکن های نشان داده شده از 

 Draw > Draw Beam/ Column/ Brace Objectمسیر: 

 

 ترسیم ستونها در حالت پلان

 

انتخاب  Continuousباید همیشه گزینه  Moment Releasesدر پنجره شناور باز شده در قسمت 

گردد تا اتصال ستون به ستون گیردار باشد. بعد ا انتخاب گزینه ترسیم ستون می توان در روی گرههای 

مورد نظر کلیک نموده و ستونها را ترسیم نمود. لام به توضیح است که اگر بخواهیم در همه نقاط تلاقی 

انجام داد. در شکل زیر نحوه  ( ستون رسم نماییم، می توان با یک کادر این کار راGridخطوط کمکی)

 ترسیم ستونها نشان داده شده است.

 پنجره شناور آیکن ترسیم ستون
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 ترسیم ستونها با یک کادر

 ترسيم تيرها 2-14-2

ید دقت نمود که در ترسیم تیرها اتصال تیر به ستون می شود. اما باترسیم تیرها نیز همانند ستونها انجام می

تواند مفصلی و یا گیردار باشد. در حالتی که سیستم مقاوم جانبی مهاربندی باشد اتصال تیر به ستون 

مفصلی و در حالتی که سیستم مقاوم جانبی قاب خمشی باشد اتصال تیر به ستون گیردار خواهد بود. برای 

 برای اتصالات گیردار گزینه  Moment Releasesره شناور ترسیم تیر می توان از کادر انجام این کار در چنپ

Continuous   و برای اتصالات مفصلی گزینهPinned  .را انتخاب نمود 
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 ابزارهای ترسیم تیر  در پلان

لازم به توضیح است که برای ترسیم تیرها زمانی که قرار است تیر یک خط کمکی را رد شود یا تیر مایل با 

   اویه دلخواه بین دو گره ترسیم گردد، باید از ابزار 

 استفاده نماییم. به عنوان مثال به شکل زیر توجه کنید.
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ها واقع شده اند تیر رسم کنیم باید بوسیله یم مابین کلیه ستونها که در تقاطع گرهاما در صورتی که بخواه

با کشیدن یک کادر بصورتی که در شکل زیر آورده  ابزار 

 شده است، تمام تیرها را ترسیم نمود.

مزاحم خط کمکی   

 تير مايل
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 ترسیم تمام تیرها با کمک کادر ترسیم

 ترسيم مهاربندها 2-14-3

انبی مهاربندی باشد باید در مکان مشخصی که بر اساس ضوابطی که قبلا در صورتی که سیستم مقاوم ج 

تواند همگرا از نوع ضربدری، به تصمیم طراح مهاربند میگفته شده است، مهاربندها را ترسیم نمود. بسته 

مورد برای ترسیم مهاربندها ابتدا قاب ای )پوپوف( باشد. نوع ذونقه زشورون هش یا هفت و یا مهاربند واگره ا

و سپس با ابزاری که در شکل زیر آورده شده است مهاربندها را می توان ترسیم نمود. لازم به نظر انتخاب 

توضیح است که اتصال مهاربندها به تیر و ستون همیشه و در هر حالتی مفصلی است. لذا در قسمت 

Moment Releases  بصورت پیش فرض همیشه گزینهPinned  .فعال است که باید به این صورت باقی بماند

در علت این موضوع باید گفت که مهاربندها نیروهای جانبی را بصورت تلاش محوری داخلی درک می 

نمایند و بر اساس نیروی محوری ایجاد شده در المان مهار بند طراحی می گردند. به همین خاطر باید اتصال 

 گیرد. مهاربند همیشه بصورت مفصلی انجام
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انواع مهاربندها را بصورت دلخواه ترسیم  Bracingدر قسمت پنجره شناور ترسیم مهارند می توان از قسمت 

فعال باشد. اگر هدف ترسیم مهاربند شورون  X نمود. در این قسمت برای ترسیم مهاربند ضربدری باید گزینه

 هشت است باید بصورت زیر اقدام شود.
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 ن هفت باشد باید پنجره شناور بصورت زیر تنظیم شود.اگر هدف مهاربند شورو

 

ای )پوپوف( باشد پنجره شناور باید بصورت زیر تنظیم گردد. در این مثال اگر هدف ترسیم مهاربند ذوزنقه

 متر در نظر گرفته شده است. 1/1طول تیر پیوند 
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 ترسيم تيرهای فرعی  2-14-0

نوع عرشه فولادی است، لذا تیرهای فرعی سقف باید مدلسازی گردند. با توجه به اینکه در این جزوه سقف از 

در مدلسازی تیرهای فرعی ابتدا باید فاصله تیرهای فرعی سقف مشخص گردد. بر اساس تجربه و با توجه به 

. لازم به متر انتخاب نمود 8توان فاصله تیرهای فرعی را ی موجود برای سقف عرشه فولادی میمحدودیتها

ریزی،  ریزی دال سقف عرشه فولادی و تجمع بتن در هنگام بتنست که با توجه به عدم دقت در بتنتوضیح ا

در صورتی که فاصله تیرهای فرعی بیشتر از حد مشخصی باشد خیز تیرها در حین اجرا بیشتر از مقدار مجاز 

ظر طراحی هم قابل شده و ارتعاش قائم سقف و لرزش سقف قابل تحمل برای ساکنین نخواهد بود که از ن

قبول نیست. برای ترسیم تیرهای فرعی می توان ا ابزاری که در شکل زیر نشان داده شده است استفاده 

 نمود.

 
متر در نظر گرفته  8همچنان که در پنجره شناور نشان داده شده است، بیشترین فاصله برای تیرهای فرعی 

است. لذا  yشده است. همچنان که در پنجره شناور دیده می شود، ترسیم تیرهای فرعی در راستای محور 

جی انتخاب شود تا باید دقت نمود که در سقف عرشه فولادی بهتر است جهت تیرهای فرعی بصورت شطرن

علاوه بر توزیع یکنواخت بارهای ثقلی مابین تیرهای اصلی، مهار جانبی تیرهای اصلی نیز تامین گردد و 

تیرها در قسمت بال فشاری دچار کمانش موضعی بال فشاری نشوند. پس در دهانه هایی که می خواهیم 

 رت زیر اصلاح کنیم.باید در پنجره شناور تنظیمات را بصو xتیرها در راستای محور 
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 بعد از انجام تنظیمات می توان تیرهای فرعی را بصورتی که در شکل زیر آورده شده است ترسیم نمود.

 

در همه طبقات اند. رهای فرعی بصورت شطرنجی ترسیم شدهها، تیهمچنان که دیده می شود، در همه دهانه

 باید بصورت روش گفته شده تیرهای فرعی را ترسیم نماییم. 

 ترسيم المانهای سطحی)سقف( 2-14-8

برای ترسیم سقف طبقات از آیکن های نشان داده شده در شکل زیر استفاده می شود. برای ترسیم کف 

 طبقات باید حالت نمایش در حالت پلان باشد.
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 آیکنهای ترسیم سقف)دال بتنی( عرشع فولادی

توزیع بار بصورت  Deckتعریف شده است. لذا در حالت   Deckدر سقف عرشه فولادی دال بتنی بصورت 

یکطرفه است. بنابراین در ترسیم دال بتنی باید دقت شود که جهت توزیع بار عمود بر تیرهای فرعی باشد. 

می توان جهت توزیع بار را تنظیم نمود. در حالتی که عدد  Local Axisا در پنجره شناور در قسمت لذ

وارد شود توزیع بار در  22و در صورتی که عدد  x مقابل گزینه فوق صفر باشد، توزیع بار در راستای  محور

 خواهد بود. yراستای  محور 

 
 

 

 بعد از تنظیم راستای توزیع بار، دال بتنی بصورتی که در شکل زیر آورده شده است، ترسیم می گردد.

 xتوزيع بار در راستای محور 

 yتوزيع بار در راستای محور 
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 ترسیم دال بتنی سقف عرشه فولادی

 

ترسیم شود. برای ترسیم راه پله کافی  Openingپله هم باید بصورت پانل راه ها،ترسیم سقف زبعد ا

نجره شناور پ Propertyتنظیمات پنجره شناور بصورت زیر اصلاح شود. بطوری که در قسمت که  است

  انتخاب گردد.  Openingگزینه 

 
 Openingترسیم راه پله بصورت 
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 اصلاح مدلسازی 2-11

 Base Storyخرپشه و طبقه اصلاح   2-11-1

اصلاح گردد.  Base Storyبعد از ترسیم المانهای سطحی و خطی در تمام طبقات باید طبقه خرپشته و 

در ادامه آورده شده همچنین برای اعمال رفتار واقعی سازه باید یکسری تنظیمات روی مدل انجام شود که 

در اصلاح طبقه خرپشته باید دقت کنیم هیچ المانی به غیر از تیر، ستون و سقف طبقه خرپشته باقی  است.

ابتدا حالت طبقه در  برای این کار. نیز نباید هیچ المانی باقی بماند  Base Storyنماند. همچنین در طبقه 

one Story  ود. سپس با انتخاب طبقه خرپشته و شقرار داده میBase Story  همه المانهای اضافی پاک

  دو طبقه موارد موجود بصورت شکلهای زیر خواهد بود.گردد؛ بطوری که در این می

 

 سقف خرپشته  اصلاح
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  Story Baseاصلاح 

 اختصاص تکيه گاهها 2-11-2

 گاهها اختصاص( از مسیر زیر تکیهone storyبعد از انتخاب تمام گره ها)در حالت   Baseدر پلان طبقه 

 داده می شود.

 Assign > Joint > Restraints مسیر:  

 

 گاههانمایش درجات آزادی تکیه
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برای سازه هایی با سیستم مهاربندی تکیه گاهها مفصل و برای سازه هایی با سیستم قاب خمشی : 1نکته

 تکیه گاهها گیردار خواهند بود.

 آن درجه آزادی می باشد.وجود تیک در هر کدام از گزینه ها به منزله بستن : 2نکته

تنظیمات مربوط به حالتهای مختلف سیستم مقاوم جانبی در دو راستای عمود بر هم در شکلهای زیر آورده 

لازم به توضیح است که بر اساس نوع سیستم مقاوم جانبی سازه در هر کدام از جهات، با انتخاب شده است.  

ها بر اساس مفصلی یا گیردار گاهنشان داده شده است، تکیهها که برای حالتهای مختلف هر کدام از گزینه

 یابد.بودن آن جهت اختصاص می

 

 هر دو راستا مهاربندی -)مهاربندی(درجات آزادی مربوط به سیستم مقاوم جانبی قاب ساده

 

 هر دو راستا خمشی -درجات آزادی مربوط به سیستم مقاوم جانبی قاب خمشی



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

83 
 

 

 خمشی( Yمهاربندی و راستای  Xسیستم ترکیبی)راستای درجات آزادی مربوط به 

 

 مهاربندی( Yخمشی و راستای  Xدرجات آزادی مربوط به سیستم ترکیبی)راستای 

توان تکیه گاه مناسب با آن جهت را های فولادی، میبنابراین بر اساس نوع سیستم مقاوم جانبی در سازه

در این جزوه با توجه به اینکه سیستم مقاوم جانبی قاب خمشی است پس تنظیمات مربوط به  اختصاص داد.

 تکیه گاهها بصورت زیر می باشد.

 
 اختصاص تکیه گاههای گیردار



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

84 
 

 اختصاص ديافراگم 2-11-3

 های سازه ای تحمل کننده بارهای ثقلی در ساختمان ها هستند، در هنگام وقوعدیافراگم ها که معمولا کف

ها را به عناصر قائم باربر جانبی بر عهده دارند. این ل نیروهای جانبی ایجاد شده در کفزلزله وظیفه انتقا

 ، مقاومت و سختی کافی را دارا باشند.شودهای افقی که در آنها ایجاد میفراگم ها باید در برابر تغییرشکلدیا

و پیوست چهارم  2-3 را از بند 8222نامه ضوابط آیینتوان ها میبرای مطالعه بیشتر در رابطه با دیافراگم

 برای اختصاص دیافراکمها ابتدا باید کلیه کفها از مسیر زیر انتخاب گردند. بررسی کرد.

  Select > Select >  Object Type > Floorsمسیر: 

 .بعد از انتخاب کفها، دیافراگم بصورتی که در شکل نشان داده شده است اختصاص می یابد 

 

 مسیر اختصاص دیافراگم سازه

)صلب( انتخاب  Rigidکه باید دیافراگم   شکل زیر ظاهر خواهد شد. Diaphragmsبعد از انتخاب گزینه 

 و اختصاص یابد.



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

85 
 

 
 مسیر انتخاب دیافراگم صلب برای سازه

استفاده  Semi Rigidلازم به توضیح است که برای دیافراگم های نیمه صلب یا منعطف می توان از گزینه 

ها به یکدیگر متصل شده و در روی هر کدام ا های متصل به کفبعد از اختصاص دیافراگم تمام گره نمود.

قابها تغییر مکان نسبی بین گرهها صفر می گردد. از اینرو می توان گفت که با اختصاص دیافراگم نیروی 

 صفر در نظر گرفته می شود. داخلی تیرها و همچنین تغییر طول محوری تیرها در هر حالتی
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 های طبقاتنمایش اختصاص دیافراگم به کف
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 نکته طراحی 

ای قرار بگیرد که، مستقیما به مهندسین طراح باید دقت نمایند که، در صورتی که مهاربند در دهانه

مقاوم  دیافراگم یا کف طبقات متصل نباشد، با توجه به اینکه توزیع نیروی جانبی بین سیستمهای

گیرد، در عمل مهاربند نخواهد توانست سهم قابل توجهی از جانبی از طریق کف و یا دیافراگم صورت می

 نیروی جانبی را دریافت نماید. 

 

 

تواند باشد. این موضوع میبر اساس شکل بالا مشاهده می گردد که مهاربند مستقیما به دیافراگم متصل نمی

بارهای جانبی با مشکل مواجه سازد. توصیه می شود تا حد امکان از قرار دادن عملکرد مهاربند را در مقابل 

شود ها جلوگیری گردد. اما در صورتی که ناچارا مهاربند در این حالت استفاده میمهاربند در اینگونه دهانه

بتواند از را با اتصال صلب به ستونها گیردار نمود تا مهاربند  C-Dو  D-Eتوان تیرهای مابین محور می

 نیروهای جانبی سهم قابل توجهی بوسیله اندرکنش قاب و مهاربند دریافت نماید. 

 

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

88 
 

 اختصاص انتهايی صلب 2-11-0

خطوط مدل شده نماینده محور مرکزی)آکس( المانها می باشند؛ از طرفی در تحلیل  Etabsدر نرم افزار 

سازه باید طول آزاد المانها مدنظر باشد. به همین خاطر باید از مسیر زیر با اختصاص نواحی صلب انتهایی 

 برای طراحی در نظر گرفته شوند. طول آزاد المانها مشخص 

 

نواحی  تواناز طریق مسیری که نشان داده شده است. میب می گردد. سپس انتخا Allابتدا با انتخاب گزینه 

 صلب انتهایی را اختصاص داد.

 All                        Assign > Frame > End length offsetsمسر: 

 

 اختصاص نواحی صلب انتهائی

 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

89 
 

 آزاد سازی انتهايی تيرها  2-11-8

اتصالات تیر به ستونها مفصلی می باشد. با توجه به اینکه در موقع در سازه های فولادی مهاربندی شده 

احتمالا در اکثر مواقع با همان  باشدترسیم تیرها اتصال پیش فرض برنامه برای تیرها از نوع گیردار می

انتهای تیرها بعد از انتخاب تیرها از مسیر زیر عمل اتصالات گیردار ترسیم خواهد شد. لذا برای آزادسازی 

لازم به توضیح است که، در آزادسازی پیچش برای اتصالات تیر به ستون، پیچش یک انتها باید  کنیم.می

 آزاد گردد تا ناپایداری چرخشی برای تیرها بوجود نیاید.

    Select >Select  Object Type > Beams >               Assign > Frame > Releases/Partial Fixityمسیر:  

 

 : آزادسازی انتهائی تیرها74شکل
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 اختصاص مشخصات 2-12

بعد از اصلاح مدلسازی باید مشخصات مقاطع به المانها اختصاص داده شود. برای اختصاص مقاطع به المانها 

 های فولادی دو روش وجود دارد.در سازه

مقطع مورد نظر  ادامه،گفته شده در در این روش ابتدا المان مورد نظر انتخاب و سپس از مسیر  روش اول:

شود، می شود. با توجه به اینکه در این روش برای هر عضو مقطع دلخواه اختصاص دادهاختصاص داده می

استفاده از این روش به دلیل طولانی  ،بندی مقاطع براحتی قابل انجام است. اما برای افراد کم تجربهپس تیپ

 شود.بودن پروسه طراحی توصیه نمی

   Assign > Frame > Section Propertyمسیر: 

 

 

 

توان، مقطع مورد که، در شکل بالا مشخص شده است، میقسمتی  زدر این روش با انتخاب مقطع مناسب ا

اند اختصاص داد. باید دقت کرد که در این روش از ابتدا باید نظر را به عضو و یا اعضایی که انتخاب شده

  بندی در طبقات رعایت گردد.یابد که، تیپ فولادی بصورتی اختصاصستونها و تیرهای انتخاب و به 

  Auto Select Listدر این روش ابتدا برای هر نوع المان یک جعبه مقاطع مناسبی تحت عنوان روش دوم:

شود. در این روش، مقطع مناسب برای هر المان از بین مقاطع موجود در تهیه و به المانها اختصاص داده می

گردد. در این روش به دلیل انتخاب مقطع بر اساس ظرفیت مقاطع تعریف شده برای المانها انتخاب میجعبه 

لذا بیشتر بوده و عملا اجرایی نخواهد بود.  المانها بعد از طراحی مورد نیاز در هر المان، تنوع در تعداد مقاطع

 بندی و اجرایی شوند.  باید بعد از طراحی مقاطع المانها تیپ

 ت جعبه مقاطع ستونها از مسیر بصورتی است که در شکل زیر نشان داده شده است.ساخ
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شکل زیر ظاهر می گردد که باید مقاطع دلخواه را برای ستونها از  Auto Select Listبعد از انتخاب گزینه 

انتخاب و  Addتوسط گزینه Auto Select List  به قسمت Choose Section in Auto Select Listقسمت 

 انتقال دهیم. 

 

 ساخت جعبه مقاطع برای ستونها
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توان با انتخاب ستونها جعبه فوق را بصورتی که در می  Auto Select Listانتقال مقاطع به قسمت  زبعد ا

 ادامه آورده شده است به تمام ستونها اختصاص داد.

 

 
 مقاطع مورد نظر برای ستونها انتخاب 

 جعبه مقاطع برای ستونهامسیر انتخاب و اختصاص 

 Select >Select  Object Type > Columns           Frame > Section Property >  Column 

 

  Auto Select Listاختصاص مقطع بصورت

و  Beamهای مقاطع بصورت همانند ستونها این مراحل باید طی شده و جعبهبرای تیرها و مهاربندها نیز 

Brace .ساخته شده و اختصاص یابد 
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  بارگذای ثقلی سازه 2-13

 تنظيم بسته بارگذاری  2-13-1

این امکان وجود دارد که بارهای گسترده یکنواخت بصورت یک بسته  Etabs 2015افزار در نرم

( از مسیر زیر تعریف شده و در نهایت اختصاص یابد. لذا برای بام و طبقات دو Uniform lead Setsبارگذاری)

 شود.بسته بارگذاری بصورت جداگانه تعریف می

 Define > Shell Uniform Loead Setsمسیر: 

 

در شکل بالا بسته بارگذاری برای بارهای گسترده طبقات آورده شده است. برای بالکنها و طبقه بام هم از 

 همان مسیر جعبه بارگذاری بصورت زیر تهیه می گردد.

 

 بسته بارگذاری طبقه بام



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

94 
 

 

 هابسته بارگذاری طره

 اختصاص بارگذاری بام  2-13-2

 گام اول: اعمال بارهای گسترده بام 

 بعد از انتخاب سقف طبقه بام از مسیر زیر بارگذاری اعمال می شود.

Assign >shell load > Uniform Load Sets 

 

 مسیر اختصاص بارهای گسترده بام
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را  Roof Loadsشکل زیر ظاهر می گردد. که از آن  Uniform Load Setsبعد از انتخاب گزینه 

 انتخاب میکنیم و به طبقه بام اختصاص می دهیم.

 

 اعمال بسته بارگذاری بام

 

  گام دوم: بارگذاریwall ديوارهای جانبی در بام 

بالا ، وزن هر طبقه شامل نصف دیوار از پایین و نصف دیوار از 8222با توجه به اینکه بر اساس آیین نامه 

انتخاب شده و در ترکیبات  Otherن آکه نوع  Wallگردد، باید نصف ون دیوارهای طبقه بام را بصورت بار می

لازم به توضیح است که، بار اصلاح گردد.  مبار نقشی نخواهد داشت در طبقه بام اعمال نماییم تا وزن طبقه با

wall دیوارهای پیرامونی باید اعمال گردد. بار دیوارهای ها( و هم برای هم برای بار دیوارهای جداکننده)تیغه

جداکننده در داخل بسته بارگذاری بصورت گسترده اعمال شده و در این مرحله بار دیوارهای جانبی باید 

انتخاب شود، سپس از مسیر یر بار دیوارهای جانبی تیرهای اطراف بام  برای اعمال ابتدا باید اعمال شود. 

 اختصاص می یابد.

 Assign > Frame loads > Distributedیر: مس
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 مسیر اختصاص بار خطی

شکل زیر ظاهر می گردد که باید بصورتی که نشان داده شده است، بار  Distributedبعد از انتخاب گزینه 

 اعمال شود.

 

 دیوارهای جانبی در بام Wallاعمال بار 

 

 

 

 ؟
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 گام سوم: بارگذاری ديوارجان پناه در بام 

 بار جانپناه را اعمال میکنیم:بعد از انتخاب تیرهای اطراف بام از مسیر زیر 

 Assign > Frame loads > Distributedمسیر: 

 

 پناه در باماعمال بار دیوار جان

 

 گام چهارم: بارگذاری آسانسور 

نفرات( آسانسور، توسط های تعادل و وزن ظرفیت )وزن بار آسانسور آعم از وزن اتاقک، تجهیزات، وزنه

شرکت سازنده آسانسور اعلام خواهد شد. از طرفی مبحث ششم مقررات ملی برای بار آسانسور ضریب ضربه 

ای در را پیشنهاد داده است. پس وزن آسانسور با اعمال ضریب ضربه در تراز طبقه بام بصورت نقطه 8

تن در نظر گرفته شود، با  3وزن آسانسور  چهارگوشه موقعیت آسانسور بصورت زیر اعمال خواهد شد. اگر

 تن اعمال خواهد شد. 1/1تن خواهد بود؛ که برای هر گوشه آسانسور  6اعمال ضریب ضربه، بار اعمالی 

 شود.ابتدا چهار گوشه موقعیت آسانسور انتخاب شده، سپس بار از طریق مسیر زیر اعمال می

 Assign > Jiont Loads > Forceمسیر: 

 ؟
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 های موقعیت آسانسورگوشهانتخاب 

 

 مسیر اختصاص بار نقطه ای برای آسانسور
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 ای آسانسوراعمال بار نقطه

 

 ری طبقاتبارگذا 2-13-3

 گام اول: اعمال بارهای گسترده بام 

 بعد از انتخاب سقف طبقه بام از مسیر زیر بارگذاری اعمال می شود.

Assign >shell load > Uniform Load Sets 

 

 اختصاص بارهای گسترده طبقاتمسیر 
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را انتخاب  Floor Loadsشکل زیر ظاهر می گردد. که از آن  Uniform Load Setsبعد از انتخاب گزینه 

 کنیم و به طبقه بام اختصاص می دهیم.می

 

 اعمال بسته بارهای گسترده طبقات

 بارگذاری ديوارهای جانبی طبقات: گام دوم 

 پیرامونی از مسیر زیر بارگذاری اعمال می شود.بعد از انتخاب تیرهای 
Assign > Frame loads > Distributed 

 
 مسیر اختصاص بار خطی
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شکل زیر ظاهر می گردد که باید بصورتی که نشان داده شده است، بار  Distributedبعد از انتخاب گزینه 

 اعمال شود.

 

 

 اعمال بار دیوارهای پیرامونی طبقات

  :بارگذاری ديوارهای جانبی راه پلهگام سوم 

 پله از مسیر زیر بارگذاری اعمال می شود.بعد از انتخاب تیرهای پیرامونی راه

Assign > Frame loads > Distributed 

 
 پلهمسیر اختصاص بار خطی راه



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

102 
 

شکل زیر ظاهر می گردد که باید بصورتی که نشان داده شده است، بار  Distributedبعد از انتخاب گزینه 

 اعمال شود.

 

 پلهراهاعمال بار دیوارهای پیرامونی 

 

 بارگذاری راه پله: 2-13-0

 پله بصورت شکل زیر است:ای که در این جزوه در نظر گرفته شده است، پلان تیرریزی راهدر پروژه

 
 پلان راه پله 
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در این پروژه یک پبه چهار طرفه است که بار آن به چهار تیر اطراف خود وارد می گردد. لذا راهپله موجود 

ی بار رمپ اول که در شکل زیر نشان داده شده است، به تیرهایی که متصل شده است در طولی به اندازه

 عرض رمپ باید وارد شود.

 

کنیم. سپس همچنان که در پ را انتخاب میبرای بارگذاری رمپ نشان داده  شه ابتدا تیرهای متصل به رم

 کنیم.ادامه آورده شده است بارگذاری را در طولی از تیر که رمپ به آن متصل شده است اعمال می

 

 بعد از انتخاب تیرها از مسیر زیر که نشان داده شده است بارهای خطی را در طولی از تیر اعمال میکنیم.
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 تیرهای اطراف پله بهمسیر اختصاص بار خطی راه

 پله آورده شده است.در شکل زیر نحوه اعمال بار خطی در طولی از تیر برای راه

 

اند. یعنی انتهای رمپ که به تیر متصل شده 4/4یعنی ابتدا رمپ و عدد  24/1عدد  Distanceدر قسمت 

 434پله برابر راه مقدار بار هم برابر است با شدت بار ضربدر سهم بارگیر تیر که مقدار شدت بار مرده

کیلوگرم بر مترمربع و سهم بارگیر هر تیر 
   

 
مانده هم به روش باشد. سپس در ادامه بار سه رمپ باقیمی 

 گفته شده اعمال می گردد. در نهایت بار نده هم بصورت بار مرده اعمال می گردد.
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 تحليل سازه 2-10

تحلیل شود. با توجه به نوع بارگذاری زلزله و تعریف بعد از اتمام مدلسازی و بارگذاری سازه، سازه باید 

لیل قبل از انجام تح لازم است که، بارهای جانبی، تحلیل در این مرحله تحلیل استاتیکی معادل خواهد بود.

 باید تنظیمات لازم صورت گیرد.

 

 

 کنترل مدلسازی و جزئيات  2-10-1

 Analyze > Check Model مسیر: 

 

 مدلسازی مسیر کنترل جزئیات

ها فعال شود گردد که در آن باید تیک تمام گزینهشکل زیر ظاهر می …Chek Modelبعد از انتخاب گزینه 

تواند اتفاق بیافتد نمایش داده شود تا قبل از تحلیل سازه در صورتی که تا تمام مواردی که در مدلسای می

 مشکلی وجود داشته باشد رفع گردد.
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 کنترل مدلسازی

 نبود مشکل پیغام زیر نمایش داده می شود. در صورت

 

 نمایش پیغام برای ایرادات و اشکالات مدلسازی 
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 Analyzeتنظيمات منوی   2-10-2

بعدی های سهلازم است قبل از انجام تحلیل درجات آزادی سازه برای انجام تحلیل مشخص گردد. در سازه

 آزادی خواهیم داشت.شش درجه آزادی و در قابهای برشی)دوبعدی( سه درجه 

 Analyze > Set Active Degrees of freedomمسیر:

 

 مسیر انتخاب درجات آزادی سازه

 

  

 بعدیتنظیم تعداد درجات آزادی مدل سه
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 تنظيم الگوهای بار برای تحليل 2-10-3

توان از این قسمت آنها را در صورتی که بخواهیم تعدادی از الگوهای بار تعریف شده، تحلیل نشوند، می

 تحلیل آن را غیر فعال نمود. Run/Do Not Run Caseانتخاب و بوسیله گزینه 

 Analyze > Set load Cases to Runمسیر: 

 

 مسیر انتخاب الگوهای بار

 انتخاب الگوهای بار برای تحلیل 
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 شروع تحليل 2-10-0

 ه از مسیر زیر اقدام می شود.زبرای انجام تحلیل سا

 Analyze >Run Analysisمسیر: 

شود؛ لزوما افزار حاصل میای که از نرمگردد. اما باید دقت کنیم که هر نتیجهدر این مرحله سازه تحلیل می

نان که قبلا نیز گفته شده است، با توجه به اینکه بخشی از اطلاعات سازه چقابل قبول نخواهد بود. چون هم

باشد؛ پس افزار نیز بعلت قفل شکسته بودن دارای خطا میو همچنین خود نرم گرددتوسط طراح تعریف می

ات خروجی باید دقت کافی بعمل آید تا نتایج غیرمنطقی و غیرقابل قبولی توان گفت در رابطه با اطلاعمی

حاصل نشود. در صورتی که نتایج برخلاف واقعیت مهندسی باشد باید بر اساس منطق مهندسی مهندس 

 تشخیص و بعد از کنترل اصلاح گردد.طراح 

 

 مسیر انجام تحلیل سازه

 

 های تحليلکنترل خروجی 2-10-8

 های آن کنترل شود تا از صحت تحلیل اطمینان حاصل شود.ل سازه باید نتایج تحلیل و خروجیبعد از تحلی
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 :گام اول: کنترل گزارش تحلیل   Analyze > Last Analysis Run Log  

 
باید سازه  WARNING  وجود داشته باشد. در صورت وجود WARNINGدر گزارش تحلیل نباید هیچ گونه 

را برطرف نمود باید مدلسازی و تحلیل سازه  WARNINGبررسی و مشکل رفع گردد. در صورتی که نتوان 

 مشاهده گردد.   ANALYSIS COMPLETEدوباره انجام شود. و در پایان هر گزارش باید 

 

 نمایش گزارش تحلیل

 گام دوم: کنترل تغییر شکل استاتیکی سازه 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

111 
 

سازه در تحلیل استاتیکی معادل باید بر اساس مود اول، تغییر شکل جانبی داشته باشد. برای نمایش تغییر 

 شکلهای سازه از مسیر زیر اقدام می شود.

 Display > Deformed shapeمسیر: 

 

 مسیر نمایش تغییر شکلهای سازه

شکل زیر ظاهر می گردد که در آن بای نماش تغییر شکلهای  Deformed Shapeبعد از انتخاب گزینه 

 انتخاب گردد. Eyباید   yو برای نمایش تغییر شکلهای راستای Exباید  Caseدر قسمت  xراستای 

 

 انتخاب الگوی بار برای نمایش تغییر شکل
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 نمایش تغییر شکل جانبی سازه

 

 های تحليلخروجینمايش  2-18

 شود.تحلیل بصورت زیر اقدام می هایخروجیبرای نمایش 

 نمايش نيروهای داخلی المانها   2-18-1

 Display > Forces/ Stress Diagram > Frame/ pier/ Spandrel/link Forcesمسیر: 
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 مسیر نمایش نیروهای داخلی

 

 صفحه انتخاب نوع تلاش داخلی و الگوی بار
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تحت بارگذاری بار مرده انتخاب شده است  3-3برای مثال در شکل بالا دیاگرام نیروی داخلی لنگر خمشی حول محور 

 را انتخاب کنیم دیاگرام لنرگ داخلی المانها بصورت زیر نمایش داده خواهد شد. Okکه در صورتی که گزینه 

 

 

 3-3نمایش دیاگرام لنگر داخلی المانها حول محور 

توان بر روی آن المان کلیک راست نموده و جزئیات زیر را مشاهده نمایش جزئیات تلاشهای داخلی هر کدام از المانها میبرای 

 نمود.
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 نمایش جزئیات تلاشهای داخلی یکی از المانها

نشان دهنده دیاگرام  Shear V2گاهی عضو، قسمت نشان دهنده واکنشهای تکیه Equivalent Loadقسمت 

نشان دهنده دیاگرام تلاش خمشی عضو حول محور  Moment M3، قسمت 8تلاش برشی در راستای محور 

 مقدار خیز عضو نمایش داده شده است. Deflection (Down +)است. در قسمت  3-3

 Show Tablesنمايش خروجی های از قسمت  2-18-2

توان از مسیر نشان داده شده سازه بعد از تحلیل انجام شده، میهای برای نمایش سایر جزئیات و خروجی

 اقدام نمود.

 Display > Show Tablesمسیر: 
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 های بعد از تحلیلمسیر نمایش خروجی

 

 های مختلفنمایش قسمتهای مختلف برای نشان دادن خروجی
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سختی نمایش داده می شود. برای های نشان داده شده در شکل بالا، مختصات مرکز جرم و از مابین خروجی

گزینه  Structure Results بررسی جزئیات مربوط به مرکز جرم و سختی طبقات باید در شکل بالا از قسمت

Centers of Mass and rigidity .انتخاب گردد 

 

 انتخاب گزینه نمایش مرکز جرم و سختی

 

 نمایش مختصات مرکز جرم و سختی

مختصات مرکز  YCRو  XCRهای مختصات مرکز جرم و گزینهYCM و  XCMهای در شکل بالا گزینه

دهند. برای بررسی مقدار خروج از مرکزیت باید مختصات مرکز جرم و سختی را از هم سختی را نشان می

 کم نمایم تا مقدار خروج از مرکزیت برای هر راستا مشخص گردد.

 

 نمایش فاصله مرکز جرم و سختی از مبدا مختصات
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 (LRFDطراحی سازه های فولادی) 2-16

 اعمال ضوابط طرح لرزه ای 2-16-1

ای نیز در نظر های فولادی باید ضوابط طرح لرزهقررات ملی ساختمان در طراحی سازهطبق مبحث دهم م

 1مبحث دهم مقررار ملی ساختمان اگر ضریب رفتار ساختمان کمتر از  3-1-3-12گرفته شود. مطابق بند 

 ای الزامی نیست.نظر گرفتن ضوابط طرح لرزهاشد در ب

نامه آیین ای شباهت زیادی بهاز نظر ضوابط طرح لرزه -1328ایش مبحث دهم ویر –مقررات ملی ساختمان 

AISC360-2010   تغییر داد که به شرح آن می در برنامه را نامهجزئیات این آییندارد، اما باید برخی-

 پردازیم.

  تشديد يافتهبررسی ترکيبات بار 

 ترکیب بار تشدید یافته مبحث دهم مطابق دو رابطه زیر می باشد :

D + 1.2 L + 1.2 Ω0 E 

0.85D + 1.2 Ω0 E 

مطابق منوال برنامه مطابق روابط زیر   AISC360-05/IBC2006 ترکیب  بار تشدید یافته آیین نامه  

 می باشد :

(0.9 – 0.2 SDS ) DL + Ω0QE                                (ASCE  12.4.3.2) 

(1.2 + 0.2 SDS ) DL + Ω0QE + 1.0 LL                (ASCE  12.4.3.2) 

که مقدار آن به طور SDS یک ضریب وجود دارد تحت نام  نامه فولاد آمریکاترکیب بار تشدید یافته آییندر 

زلزله در مبحث دهم  شود ضریب بار مرده ، زنده وکه دیده میاست. همانطور  8/2پیش فرض در برنامه برابر 

ه نقش اصلی را بار . البته با توجه با اینکه در ترکیب بار تشدید یافتندبا هم تفاوتهایی دار AISCو آیین نامه

ن توانیم از اختلافاتی که در زمینه ضرایب بارهای مرده و زنده وجود دارد صرفنظر کنیم و ایزلزله دارد می

 ترکیب بارها را به عنوان ترکیب بارهای تشدید یافته مورد نظر خود  قبول نماییم.

، روش حالت حدی بار زلزله دارای یک ضریب ه مبحث دهم: چون در ترکیب بارهای تشدید یافت نکته مهم

، باید این ضریب را از جدول مذکور ی برنامه وجود نداردکه در ترکیب بارهای تشدید یافته است 8/1

 در برنامه وارد گردد.ضرب کرده و سپس  8/1استخراج کرده و در عدد 
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 برای انواع سیستم های باربر جانبی لرزه ای 0Ωضریب اضافه مقاومت 

 0Ω نوع سیستم باربر جانبی لرزه ای
 3 کلیه قابهای خمشی فولادی

 8 مهاربندی هم محورو برون محور فولادیکلیه قابهای ساختمانی ساده توام با 
 1/8 کلیه سیستمهای دوگانه یا ترکیبی

 

 تحليل مرتبه دوم  2-16-2

های نسبت به روش تنش مجاز، اعمال آثار مرتبه دوم در طراحی سازه LRFDیکی از تفاوتهای بارز روش 

دوم، سه روش پیشنهاد شده  باشد. در مبحث دهم مقررات ملی برای درنظر گرفتن آثار مرتبهفولادی می

باشد. در این پروژه برای در نظر گرفتن آثار مرتبه دوم، می  AISC360-10 نامهاست که، همانند ضوابط آئین

 شود.از روش تحلیل مستقیم استفاده می

 روش تحليل مستقيم  2-16-1

-تحلیل سازه لحاظ میماند و خطاهای هندسی بطور مستقیم در در این روش اثرهای ثانویه، تنشهای پس

روش هیچ محدودیتی ندارد. در این روش  نشود. ایشوند. در این روش از ضریب طول موثر استفاده نمی

( تحلیل سازه 8( آثار نواقص هندسی)شمال کجی و ناشاقولی( در تحلیل مرتبه دوم منظور گردد. 1بایستی: 

اس سختی کاهش یافته اعضا صورت گیرد. تحلیل ( تحلیل مرتبه دوم بر اس3از نوع تحلیل مرتبه دوم باشد. 

را در برگیرد. روش تحلیل مستقیم در دو حالت سختی کاهش  P – Δو      مرتبه دوم باید هر دو اثر 

EIیافته و سختی متغیر قابل انجام است. سختی خمشی کاهش
یافته باید در همه اعضایی که سختی   *

خمشی آنها در پایداری سازه مشارکت دارند، به جای سختی عادی انها بکار رود. در تحلیل و طراحی به 

روش مستقیم برای تعیین مقاومت مورد نیاز در تحلیل مرتبه دوم باید به شرح زیر از ضرایب کاهشسختی 

( علاوه بر ضریب 8ه سختی هایی که در پایداری سازه موثرند. برای کلی 2/2( ضریب کاهش  1استفاده شود. 



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

120 
 

نیز به شرح زیر در سختی خمشی اعضایی که در پایداری    ، یک ضریب کاهش اضافی 2/2کاهش سختی 

 تواند مقداری ثابت و یا متغیر همانند رابطه زیر داشته باشد.سازه موثرند اعمال شود. این مقدار می

EI
*
= 0.8           ,         =   

 

 

مقاومت تسلیم محوری است. لازم به ذکر است که در تمام    مقاومت فشاری مورد نیاز و    در رابطه فوق 

بیش از حالت معمول،  12در نظر گرفت، به شرظی که بار جانبی مجازی را % 1را برابر    توان حالات می

 1در مبحث دهم مقررات ملی ساختمان برابر  αبرابر بارهای ثقلی اعمال نمود. مقدار  223/2یعنی به مقدار 

EAدر نظر گرفته شده است. همچنین سختی محوری کاهش یافته 
باید برای اعضایی که سختی محوری  *

 آنها در پایداری جانبی سازه مشارکت دارند بصورت زیر در نظر گرفته شود.

EA
*
= 0.8EA 

 انتخاب آيين نامه طراحی   2-16-3

 Design > Steel Frame Design > View/Revise Preferencesمسیر: 

 

 های فولادینامه طراحی سازهمسیر انتخاب آیین

1.0
αPu

Py
 0 5 

 

4
α  

  
 1  

α  

  
             

αPu

Py
 0 5 
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در ادامه آورده  AISC360-10نامه مربوط به ضوابط طراحی لرزه ای بر اساس مبحث دهم و آئین تنظیمات

 شده است. 

 

 12تا  21نامه از ردیف تنظیمات آیین

گردد. که باید بر اساس نوع سیستم مقاوم جانبی سازه نوع سیستم مقاوم جانبی انتخاب می 23در ردیف 

 توان انتخاب نمود به شرح زیر است:جانبی که در این ردیف می اعمال گردد. انواع سیستمهای مقاوم

SMF :قاب خمشی ويژه 

IMF :قاب خمشی متوسط 

OMF :قاب خمشی معمولی 

SCBF :قاب مهاربندی همگرای ويژه 

OCBF :قاب مهاربندی همگرای معمولی 

OCBFI :قاب مهاربندی همگرای معمولی جدا سازی شده  

EBF :قاب مهاربندی واگرا 
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های نامه باید از مابین گزینهینای آیخیزی انتخاب می شود. برای اعمال ضوابط لرزهه لرزهمنطق 24ردیف  در

A ،B  وC های یکی به اختیار انتخاب گردد. در صورتی که ناحیه بایدD ،E  وF ای انتخاب شوند ضوابط لرزه

 وارد گردد. 1/3رفتار بیش از  ضریب 22گردد که در ردیف برای سازه توسط برنامه مانی اعمال می

( وارد میگردد که ρضریب نامیعنی سازه) 26ضریب اهمیت سازه وراد می گردد. در ردیف  21در ردیف 

، 22ها در پیوست جزوه آورده شده است. مقدار ضریب رفتار در ردیف چگونگی تعیین آن برای انواع سازه

جدول مبحث دهم که برای  زمقدار آن بعد ا استخراج اوارد می گردد که  22( در ردیف 0Ωضریب تشدید)

 12در ردیف  ضرب و در این ردیف وارد گردد. 8/1هر سیستم مقاوم جانبی مشخص شده است، باید به عدد 

برای تبدیل تغییر مکانهای الاستیک به غیر الاستیک)از جدول آئین نامه این ضریب وارد میگردد.  Cdمقدار 

-انتخاب می 8222نامه آیین 4-3که، مقدار آن برای هر سیستم مقاوم جانبی از جدول  رودبکار می (8222

 گردد.

و همچنین   Direct Analysisگزینه 18برای انجام تحلیل مرتبه دوم به روش تحلیل مستقیم باید در ردیف 

مقدار  Tau-b Fixedانتخاب شود. همچنین با انتخاب گزینه General 2nd Order گزینه  13در ردیف 

  شود.درنظر گرفته می 1ضریب کاهش سختی ناشی از تنشهای پسماند 

 

 32تا  81نامه از ردیف تنظیمات آیین
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انتخاب شود ترکیبات تشدید یافته ساخته نخواهند شد. همچنین   Yesدر صورتی که گزینه 81در ردیف 

تنها در قابهای خمشی  87شود. ردیف ای کنترل نمیانتخاب شود ضوابط لرزه Yesگزینه  86اگر در ردیف 

به این معنی است  Yesکاربرد دارد. این گزینه برای طراحی ضخامت ورق مضاعف کاربرد دارد. انتخاب گزینه 

به معنی جدا بودن  Noشود. گزینه که ورق مضاعف به جان ستون با جوش کام و انگشتانه اتصال داده می

شود. وقتی مقاطع جدار نازک توخالی در این قسمت معرفی می روش جوشکاری 82این دو ورق است. ردیف 

برابر ضخامت اسمی  0.93باید  t)قوس الکتریکی تحت حفاظت( باشد، ضخامت ERWجوشکاری از نوع 

ور( ضخامت مزبور باید معادل )قوس الکتریکی غوطه SAWجداره و برای مقاطع جوشکاری شده به روش 

کاهش و یا عدم کاهش ضخامت ورق مقطع  82در ردیف  شود. ضخامت اسمی جداره در نظر گرفته

شود. چون این کاهش در مبحث دهم اشاره نشده، مقدار آن ای( مشخص میای و جعبهجدارنازک بسته) لوله

 دهیم.قرار می Noرا 

 

 اختصاص پارامترهای طراحی   2-16-0

 هااختصاص پارامترهای طراحی ستون  2-16-0-1

 Design > Steel Frame Design > View/Revise Overwritesانتخاب ستونها و مسیر: 

 

 

 مسیر اختصاص پارامترهای طراحی
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که در تنظیمات آن ضریب  شکل زیر ظاهر خواهد شدView/Revise Overwrites بعد از انتخاب گزینه 

برای ستاونها باید به جدول مبحث دهم که در زیر  Ryباید وارد گردد. برای انتخاب  Ryطول موثر و ضریب 

اند، پس در نظر گرفته شده Boxآورده شده است رجوع شود. با توجه به اینکه مقاطع ستونها در این جزوه 

ونها نشان داده شده انتخاب و همانطور که در تنظیات مربوط به پارامترهای طراحی ست 81/1برابر  Ryمقدار 

 .گردداست اعمال می

 برای انواع تولیدات فولاد Ryمقادیر 

 Ry نوع محصول

 81/1 مقاطع لوله ای و قوطی شکل نورد شده

 82/1 شکل، ناودانی، نبشی و سپری Hشکل،  Iسایر مقاطع نورد شده شامل مقاطع 

 11/1 مقاطع ساخته شده از ورق ها و تسمه ها

 

 

 تنظیمات مربوط به پارامترهای طراحی ستونها

-وارد می 1یر ضرایب طول موثر عدد روش تحلیل مستقیم استفاده شده است، پس مقاد به اینکه ازبا توجه 

کند. همچنین لازم است گفته شود که  میشود برنامه از مقدار آن صرفنظر  وارد 1شود. اگر عددی به غیر از 

  باشد.ضریب تنش تسلیم مورد انتظار می    
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 اختصاص پارامترهای طراحی تيرها  2-16-0-2

 Design > Steel Frame Design > View/Revise Overwritesانتخاب تیرها و مسیر: 

 

 مسیر اختصاص پارامترهای طراحی

با توجه  که در تنظیمات آن شکل زیر ظاهر خواهد شدView/Revise Overwrites بعد از انتخاب گزینه 

برابر صفر و مقدار طول  12خیزی در نظر نگرفته است این مقدار در ردیف به اینکه مبحث دهم هیچ پیش 

گردد. با توجه به اینکه سقف سازه مورد نظر در این جزوه سقف عرشه وارد می 83مهار نشده هم در ردیف 

 فولادی است، لذا با توجه به تعداد تیرهای فرعی که هرکدام یک نوع مهار جانبی برای تیرهای اصلی هستند،

هم برای تیرها بر اساس شکل مقطع  Ryگردد. همچنین مقدار وارد می 333/2مقدار طول مهار نشده برابر 

گردد. همچنین وارد می 32انتخاب و در تنظیم پارامترهای طراحی در ردیف  8/1شکل است،  Iتیرها که 

اینکه در سقف تیرچه و  با توجه بهلازم به توضیح است که در صورتی که سقف سازه تیرچه و بلوک باشد، 

بلوک بال فشاری تیرها در داخل بتن مدفون هستند، پس طول مهار نشده برای بال فشاری صفر است. لذا 

 .شودافزار عددی نزدیک به صفر  وارد میدر نرم
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 تنظیم پارامترهای طراحی تیرها

بعد از اختصاص پارامترهای در این پروژه با توجه به اینکه سیستم مقاوم جانبی قاب خمشی است، لذا 

ها مهاربند نیز وجود دارد زهه باید طراحی گردد. اما با توجه به اینکه در اکثر سازطراحی تیرها، بلافاصله سا

 شود.امترهای طراحی مهاربندها گفته میدر ادامه نحوه اختصاص پار

 

 اختصاص پارامترهای طراحی مهاربندها  2-16-0-3

 Design > Steel Frame Design > View/Revise Overwritesانتخاب مهاربندها و مسیر: 
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 انتخاب ترکيبات طراحی  2-16-8

لازم به توضیح است که در طراحی سازه های فولادی، برای کنترل خیز و تغییرشکل و هم برای طراحی 

نامه طراحی که برای ترکیبات بار باید بر اساس آیینگردد. هر کدام از سازه ترکیب بار جداگانه انتخاب می

اند باید لحاظ گردد. انتخاب ترکیب بار جداگانه برای کنترل خیز در سازه های طراحی سازه انتخاب شده

فولادی حاکی از آن است که، در سازه های فولادی کنترل خیز و تغییر شکل سازه بسیار مهم می باشد. لذا 

دقت نمایند که سازه های فولادی را بیش از حد لاغر و ضعیف طراحی نکنند چرا که مهندسین طراح باید 

 گردد.برداری از سازه میهای فولادی دچار ارتعاش قائم و جانبی محسوسی در زمان بهرهدر این صورت سازه

 Design > Steel Frame Design > Select Design Combinationsمسیر: 
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 بار طراحیمسیر انتخاب ترکیبات 

 

 انتخاب ترکیبات بار سازه های فولادی

ترکیب بار طراحی سازه و از سربرگ  Strenghهمچنان که در شکل نشان داده شده است، از سربرگ 

Deflection گردد.ترکیب بار کنترل خیز انتخاب می 

 

 طراحی سازه  2-16-6

این مرحله سازه طراحی شده و نتایج حاصل از نماییم. در بعد از انتخاب ترکیبات بار، سازه را طراحی می

ای سازه اطمینان های طراحی باید کنترل گردد تا از کفایت پاسخهای لرزهطراحی تحت عنوان خروجی

 حاصل شود.
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 Design > Steel Frame Design > Start Design/Checkمسیر: 

 

 مسیر انتخاب گزینه طراحی سازه

 خروجی طراحی سازه 2-16-7

 کنترل نسبت نيرو به ظرفيت المانها 2-16-7-1

نسبت نیرو  ،Ratioانجام می شود. بوسیله  Ratioهای فولادی از طریقکنترل کفایت مقاطع المانها در سازه 

د. اگر نسبت نیرو به ظرفیت نبه ظرفیت در اعضا مشخص شده و مقاطع از نظر طراحی بررسی می گرد

توان مقاطع را قابل قبول تلقی نمود. در صورتی که نسبت نیرو به می، بوده و اقتصادی باشد 1کوچکتر از 

باشد مقاطع از نظر طراحی جوابگو نیستند و باید تغییر یابند. که در ادامه نحوه تغییر  1ظرفیت بزرگتر از 

 مقاطع المانها توضیح داده خواهد شد.

 …Design > Steel Frame Design > Display Design Infoمسیر: 
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 های فولادیهای طراحی سازهمسیر نمایش خروجی

 

 

 (Ratioانتخاب نمایش نسبت نیرو به ظرفیت المانها)

 

برای تمام المانها هم در قالب  Ratioبعد از انتخاب گزینه نمایش نسبت نیرو به ظرفیت همانند شکل بالا، 

در آن کمتر  Ratioرنگ و هم بصورت عددی نمایش داده می شود. همچنان که گفته شده است، المانی که 

نمایش داده شود،  1باشد از نظر طراحی جوابگوی تلاشهای داخلی است. اما در صورتی که بزرگتر از  1از 

 بوده و باید مقطع المان تغییر یابد. به شکل زیر توجه کنید:یعنی المان برای تلاشهای داخلی خود جوابگو ن
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می باشد. لازم  1مقدار نسبت نیرو به ظرفیت برای همه المانهای این قاب کمتر از ، چنانچه مشاهده می شود

می باشد که این نشان دهنده  1/2به توضیح است که در بعضی از المانها نسبت نیروی به ظرفیت کمتر از 

که، مقاطع این المانها بسیار بزرگتر هستند و باید  کوچکتر شوند تا مقطع اقتصادی گردد. لذا باید  این است

بندی مقاطع هم باید انجام دقت کنیم که علاوه بر اقتصادی نمودن مقاطع که بحث بسیار ضروری است، تیپ

توان آنها را قبول که ناچارا میبندی مقاطع تعدادی ا المانها غیراقتصادی شوند شود. لذا ممکن است در تیپ

 ای باشد که کلیات طرح از نظر هزینه زیر سوال باشد. نمود. اما تعداد این المانها نباید به گونه

 تيپ بندی مقاطع 2-16-7-2

بعد از آنکه تمام مقاطع از نظر طراحی مناسب بودند باید مقاطع را تیپ بندی و اجرائی نمود. باید دقت کرد 

ی فولادی تیپ بندی، در طبقاتی که قرار است در  ستونهای آنها  از یک شماره پروفیل استفاده در سازه ها
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توان برای جبران نیازهای داخلی المانها از ورقهای بندی مقاطع میدر هنگام تیپشود. شود، انجام می

کلیک راست در در حال نمایش است، با  Ratioبندی المانها در حالتی که رای تیپب استفاده کرد. نیز تقویتی

 شکل زیر ظاهر می گردد. روی عضو 

 

 صفحه کنترل اطلاعات مربوط به نسبت نیروها

 

در پنجره  پنجره مشخصات اختصاص یافته طراحی برای المان باز خواهد شد. Overwritesبا انتخاب گزینه 

مقطع مورد نظر  Current Design Sectionتوان در ردیف ظاهر شده که در زیر نمایش داده شده است، می

را انتخاب و نسبت نیرو به ظرفیت را دوباره برای آن مقطع کنترل نمود. لازم به توضیح است که، وقتی با این 

شود و نیازی نماید، بلافاصله نسبت نیرو به ظرفیت در المان فوق نمایش داده میروش مقطع عضو تغییر می

 جدد نیست.به طراحی م
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 صفحه تغییر مقطع عضو

 نمايش مقاطع طراحی 2-16-7-3

توان برای انتخاب و اختصاص یافته است، می Auto Select Listدر صورتی که مقاطع المانها به روش 

افزار از مابین مقاطع موجود در جعبه مقاطع انتخاب کرده است را، از مسیر زیر مشاهده مقطع نهایی که نرم

 مشاهده نمود. 

 …Design > Steel Frame Design > Display Design Infoمسير: 

 

 های فولادیهای طراحی سازهمسیر نمایش خروجی
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 انتخاب نمایش مقاطع طراحی 

 

 نمایش مقاطع طراحی المانها
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 تغيير مقاطع   2-16-7-0

بنابه هر دلیلی اگر بخواهیم برای چند المان یک مقطع اختصاص دهیم یا مقطع چند المان را تغییر دهیم 

 توان، بعد از انتخاب المانهای مورد نظر، از مسیر زیر مقاطع آنها را تغییر داد.می

 Design > Steel Frame Design > Change Design Section مسیر: انتخاب المانهای مورد نظر 

 

و با انتخاب گینه  شده که در شکل زیر نشان داده شده است ظاهرسپس با انتخاب مقطع مناسب از پنجره 

Ok یابد.مقطع به المانهای مورد نظر اختصاص می 

 

 تغییر مقطع چند المان



 محمدپور                       (                فولادی ی)سازه هاEtabs  2015جزوه نرم افزار 

 

136 
 

اما برای بررسی کفایت مقطعی که به المانها اختصاص داده شده است، دوباره باید از مسیر نشان داده در  

شکل زیر ساه دوباره طراحی گردد. لازم به توضیح است که در این طراحی فقط المانهایی که مقطع انها 

 مانند. می ت قبلی خود باقیی المانها در حالگردند وبقیهتغییر پیدا کرده اس طراحی شده و کنترل می

 

 مسیر انتخاب گزینه طراحی مجدد سازه

برای المانهایی که مقطع آنها تغییر پیدا کرده است، در صورت جوابگو  Ratioبعد از انتخا سازه و کنترل 

بودن مقطع مناسب خواهد بود و در صورتی که مقطع المانها مناسب نباشد دوباره باید از مسیر نشان داده 

 شده مقطع مناسب انتخاب و اختصاص یابد.

 

 

هابهترین آرزویبا   

 محمدپور

2/8/26  

 


